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Purpose  

This document includes important, late-breaking information about this release of Oracle’s 
Hyperion Reporting and Analysis – System 9. Review this information thoroughly before 
installing. 

Top 

Installation Updates 

For information on installation, see the Hyperion Reporting and Analysis – System 9 Installation 

Guide for Windows and the Hyperion Reporting and Analysis – System 9 Installation Guide for 

UNIX. 

Upgrading 

If you upgrade any Hyperion product to release 9.3.1, you must also upgrade Hyperion Shared 
Services to release 9.3.1. 

Supported Upgrade Paths 

In addition to the supported upgrade path in the Hyperion Installation Start Here, Reporting 
and Analysis also supports the following upgrade paths: 

• 9.3.0.x 

• 9.2.0.3 (as documented in the Hyperion Installation Start Here) 

• 9.2.0.2 
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If you are using a release prior to 9.2.0.2, you must first upgrade to one of the versions noted 
above, and then upgrade to 9.3.1. See the product installation guides for the products you are 
using for upgrade procedures. 

Mixed Version Deployment 

If you are upgrading Hyperion® Workspace to version 9.3.1 and plan to leave either Oracle® 
Hyperion Planning – System 9 or Oracle® Hyperion Financial Management – System 9 at 
version 9.3.0.1, see Appendix B - Deploying Hyperion Release 9.3.1 Products with Components 
from Previous Releases in the Install Start Here Guide for deployment guidance. 

Hyperion License Compliance 

Hyperion no longer ships or requires Hyperion® License Server™ (or standalone license files) 
for use with Hyperion products.   

To ensure compliance with your license agreement, Hyperion recommends that you implement 
an auditing process. In addition, during product configuration with Hyperion Configuration 
Utility, you activate only the features you purchased. After you configure each product, you 
must open the registry.properties file—in <Hyperion_Home>\common\config on the server 
on which you ran Hyperion Configuration Utility—to review and edit the product options. You 
must complete this step to ensure you comply with your license agreement and to activate 
features you are licensed to use. For more information, see “Hyperion License Compliance” in 
Hyperion Installation Start Here. 

Enterprise Metrics 

In Release 9.3.1, Hyperion® System® 9 BI+™ Enterprise Metrics ™ no longer ships with 
Hyperion® Reporting and Analysis – System 9. Enterprise Metrics Release 9.3 and Release 9.2 
continue to be supported by Reporting and Analysis Release 9.3.1. For information on using 
Enterprise Metrics with Reporting and Analysis, see the Release 9.3 or Release 
9.2 documentation. 

Top 

Documentation Updates 

The most recent version of each Hyperion product guide is available for download from the 
Documentation area of the Oracle Technical Network (OTN) Web site 
(http://www.oracle.com/technology/index.html).  

Documentation is also available from the Oracle E-Delivery Web site 
(http://edelivery.oracle.com/EPD/WelcomePage/get_form). Please note that individual product 
guides are available for download on the Oracle Technical Network (OTN) Web site only. 

Top 

Oracle Single Sign-On 

Before configuring Oracle Single Sign-On, install Oracle Application Server Infrastructure, 
Identity Management, and Metadata Repository (OID, SSO, and metadata repository). 
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Configuring Oracle Single Sign-On on the Oracle AppServer 10.1.2.0.2 

To configure Oracle Single Sign-On on the Oracle AppServer 10.1.2.0.2: 

1. Configure the Identity Management Infrastructure database: 

$ORACLE_HOME/sso/bin/ssocfg.sh <protocol> <host> <port> 

where <host> is the fully-qualified host name and <port> is the OAS Web server port. 

For example: 

$ORACLE_HOME/sso/bin/ssocfg.sh http bi-linux2.hyperion.com 7777 

2. Register SSO on the Apache server using: 

$ORACLE_HOME/sso/bin/ssoreg.sh./ssoreg.sh -oracle_home_path $ORACLE_HOME -
site_name <NAME> -config_mod_osso TRUE -mod_osso_url <URL> 

For example: 

$ORACLE_HOME/sso/bin/ssoreg.sh./ssoreg.sh -oracle_home_path $ORACLE_HOME -
site_name BIPlus -config_mod_osso TRUE -mod_osso_url http://bi-
linux2.hyperion.com:7777 

For validating registration and updating properties, log on to the following SSO 
administration page and select SSO Server Administration. 

http://bi-linux2:7777/pls/orasso  

By default all settings should be correct. 

3. Manually deploy Workspace/WA/FR/HSS on Oracle 10G by following the instructions in the 
Hyperion Reporting and Analysis – System 9 Installation Guide. 

Note: When deploying EAR files, you can automatically enable SSO by selecting “Use JAZN 
LDAP User Manager.”  

4. Log on to Oracle Console > HTTP Server > Administration > Advanced Server Properties > 
mod_osso.conf and protect/unprotect specific resources by inserting the following directives 
into <IfModule mod_osso.c>. Replace <host> with the hostname where Reporting and 
Analysis components (WA, FR, etc.) are installed. 

<Location /workspace> 
Require valid-user 
AuthType Basic 
order deny,allow 
deny from all 
allow from <host>  
satisfy any 
</Location> 

<Location /hr> 
Require valid-user 
AuthType Basic 
</Location> 
<Location /HReports> 
Require valid-user 
AuthType Basic 
</Location> 

<Location /WebAnalysis> 
Require valid-user 
AuthType Basic 
order deny,allow 
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deny from all 
allow from <host> 
satisfy any 
</Location> 

5. Log on to Oracle Console > HTTP Server > Administration > Advanced Server Properties > 
httpd.conf and append the following lines at the end of file: 

<Location /WebAnalysis/> 
OssoSendCacheHeaders off   
</Location>   

<Location /workspace/> 
OssoSendCacheHeaders off   
</Location>   

<Location /hr/> 
OssoSendCacheHeaders off   
</Location>   
<Location /HReports/> 
OssoSendCacheHeaders off   
</Location>   

6. Update BIPLUS_HOME\InstallableApps\config\WebAnalysis.properties as follows: 

1. Uncomment and set UseSecurityAgentTokenWithoutDomain to true. 

2. Update SSOProviderSessionCookieID and set the following value: 

OHS-<hostname.domain.com>-<ora_http_port> 

3. Uncomment and set UseRemoteUser to true. 

7. Restart Hyperion Core Services. 

8. Restart the Middle-Tier and Application Server instances: 

On UNIX: 

ORACLE_HOME/opmn/bin/opmnctl stopall 

ORACLE_HOME/opmn/bin/opmnctl startall 

On Windows: 

ORACLE_HOME\opmn\bin\opmnctl stopall 

ORACLE_HOME\opmn\bin\opmnctl startall 

9. Set up Workspace Web Application parameters. 

a. Start Servlet Configurator: 

<BIPLUS_HOME>/bin/config.sh 

<BIPLUS_HOME>\bin\config.bat 

b. Select Properties > User Interface > Login. 

c. Set Custom Username Policy to $REMOTE_USER$ and Custom Password Policy to 
$TRUSTEDPASS$. 

d. Select File > Save and then File > Exit. 

e. Change the settrusted password value by running: 

<BIPLUS_HOME>/bin/settrustedpass.sh 

<BIPLUS_HOME>\bin\settrustedpass.bat 
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When prompted, supply a default password of 123456; then specify a new trusted 
password. 

This script creates a file called tp.conf that contains the trusted password in an 
encrypted format. The file is automatically copied to: 

<WORKSPACE_DEPLOYMENT_DIRECTORY>/WEB_INF/config 

10. Set the Trusted Password on the Authentication Service. 

Set the same password as you did in the previous step. To set the password, you must be 
assigned the Global Administrator role.  

a. Log on to the Local Service Configurator under: 

<BIPLUS_HOME>/bin/ServiceConfig.sh 

<BIPLUS_HOME>\bin\ServiceConfig.bat 

b. Click Show host properties. 

c. Select the Authentication tab, set the password, and click OK. 

11. Configure Shared Services. 

a. Log on to Shared Services and select Administration > Configure User Directories. 

b. Select Support Security Agent for Single Sign-on and click Save. 

c. Select Requisite Provider (Oracle Internet Directory) and click Edit. 

d. Select Trusted, click Save, and restart all components. 

Configuring Oracle Single Sign-On on the Oracle AppServer 10.1.3.1.0 

To configure Oracle Single Sign-On on the Oracle AppServer 10.1.3.1.0: 

1. On the Identity Management host (where version 10.1.2.0.1 or 10.1.2.0.2 is installed), set 
the ORACLE_HOME and ORACLE_SID environment variables. 

2. On the Identity Management host, run ssoreg using -remote_midtier.  

The file is located at: 

ORACLE_HOME/sso/bin/ssoreg.sh (UNIX) 

ORACLE_HOME\sso\bin\ssoreg.bat (Windows) 

For example, on LINUX: 

$ORACLE_HOME/sso/bin/ssoreg.sh -oracle_home_path $ORACLE_HOME \ 

-config_mod_osso TRUE \ 

-site_name BIPlus \ 

-remote_midtier \ 

-config_file $ORACLE_HOME/Apache/Apache/conf/osso/myosso.conf \ 

-mod_osso_url http://myhost.domain.com:19000 

The resulting configuration file (myosso.conf in this example) is an obfuscated OSSO 
configuration file. 

3. Copy the obfuscated OSSO configuration file to the 10g Release 3 (10.1.3) middle-tier 
instance. 

4. On the middle-tier host, run the following script to complete the registration: 
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ORACLE_HOME/Apache/Apache/bin/osso1013 config_file (UNIX) 

perl ORACLE_HOME\Apache\Apache\bin\osso1013 config_file (Windows) 

If you do not have Perl, you can perform these actions manually: 

 a. Copy config_file into ORACLE_HOME\Apache\Apache\conf\osso\osso.conf 

 b. Uncomment the following line in httpd.conf:   

include "<ORACLE_HOME>\Apache\Apache\conf\mod_osso.conf" 

 c. Add the OssoConfigFile entry into mod_osso.conf and insert the following line into 
<IfModule mod_osso.c>: 

OssoConfigFile "<ORACLE_HOME>\Apache\Apache\conf\osso\osso.conf" 

For example: 

OssoConfigFile "C:\Oracle\Apache\Apache\conf\osso\osso.conf" 

5. Update Identity Management properties for Workspace: 

a. Navigate to the OC4J > Workspace > Administration page of the Oracle Enterprise 
Manager’s 10g Web site, select Identity Management Properties, and click 
Configure. 

b. Enter the fully-qualified domain name of the OID host, cn=orcladmin as user, enter the 
user’s password, enter a port value (by default non-SSL 389), and click Next. 

c. Select Use Oracle Identity Management Security Provider, and click Next. 

d. Select Use OID Security Provider and Enable SSO Authentication for Workspace 
and click Configure.   

e. Restart Workspace. 

6. Change Global Security Provider properties: 

a. At the bottom of the Administration Console, select Global Setup. 

b. Under Security Providers, select Change Security Provider. 

c. In the Oracle Identity Management Security Provider, select Created and click OK. 

7. Update Security Providers properties for Web Analysis: 

a. On the Oracle Enterprise Manager’s 10g Web site, navigate to OC4J > WebAnalysis > 

Administration and select Security Providers Properties. 

b. Select Edit for Web Analysis Application Name. 

c. Click Change Security Provider and select OIM Security Provider. 

d. Select Enable SSO Authentication and click OK. 

8. Update Security Providers properties for Financial Reporting: 

a. On the Oracle Enterprise Manager’s 10g Web site, navigate to OC4J > Financial 

Reporting > Administration, select Security Providers Properties. 

b. Select Edit for Financial Reporting Application Name. 

c. Click Change Security Provider and select OIM Security Provider. 

d. Select Enable SSO Authentication and click OK. 
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9. Update ORACLE_HOME\Apache\Apache\conf\mod_osso.conf, and insert the following lines 
into <IfModule mod_osso.c>: 

<Location /workspace> 
Require valid-user 
AuthType Basic 
order deny,allow 
deny from all 
allow from <localhost>, < Identity Management host > 
satisfy any 
</Location> 

<Location /workspace/browse/configURL> 
Require valid-user 
AuthType Basic 
allow from all 
</Location> 
<Location /hr> 
Require valid-user 
AuthType Basic 
</Location> 

<Location /HReports> 
Require valid-user 
AuthType Basic 
</Location> 

<Location /WebAnalysis> 
Require valid-user 
AuthType Basic 
order deny,allow 
deny from all 
allow from <localhost>, <Identity Management host> 
satisfy any 
</Location> 

10. Append the following lines to ORACLE_HOME\Apache\Apache\conf\httpd.conf: 

<Location /WebAnalysis/> 
OssoSendCacheHeaders off   
</Location>   

<Location /workspace/> 
OssoSendCacheHeaders off   
</Location>   

<Location /hr/> 
OssoSendCacheHeaders off   
</Location>   
<Location /HReports/> 
OssoSendCacheHeaders off   
</Location>   

11. Update BIPLUS_HOME\InstallableApps\config\WebAnalysis.properties as follows: 

4. Uncomment and set UseSecurityAgentTokenWithoutDomain to true. 

5. Update SSOProviderSessionCookieID and set the following value: 

OHS-<hostname.domain.com>-<ora_http_port> 

6. Uncomment and set UseRemoteUser to true. 

12. Restart Hyperion Core Services. 
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13. Restart the Middle-Tier and Application Server instances: 

On UNIX: 

ORACLE_HOME/opmn/bin/opmnctl stopall 

ORACLE_HOME/opmn/bin/opmnctl startall 

On Windows: 

ORACLE_HOME\opmn\bin\opmnctl stopall 

ORACLE_HOME\opmn\bin\opmnctl startall 

14. Set up Workspace Web Application parameters. 

a. Start Servlet Configurator: 

<BIPLUS_HOME>/bin/config.sh 

<BIPLUS_HOME>\bin\config.bat 

b. Select Properties > User Interface > Login. 

c. Set Custom Username Policy to $REMOTE_USER$ and Custom Password Policy to 
$TRUSTEDPASS$. 

d. Select File > Save and then File > Exit. 

e. Change the settrusted password value by running: 

<BIPLUS_HOME>/bin/settrustedpass.sh 

<BIPLUS_HOME>\bin\settrustedpass.bat 

When prompted, supply a default password of 123456; then specify a new trusted 
password. 

This script creates a file called tp.conf that contains the trusted password in an 
encrypted format. The file is automatically copied to: 

<WORKSPACE_DEPLOYMENT_DIRECTORY>/WEB_INF/config 

15.  Set the Trusted Password on the Authentication Service. 

Set the same password as you did in the previous step. To set the password, you must be 
assigned the Global Administrator role. 

a. Log on to the Local Service Configurator under: 

<BIPLUS_HOME>/bin/ServiceConfig.sh 

<BIPLUS_HOME>\bin\ServiceConfig.bat 

b. Click Show host properties. 

c. Select the Authentication tab, set the password, and click OK. 

16. Configure Shared Services. 

a. Log on to Shared Services and select Administration > Configure User Directories. 

b. Select Support Security Agent for Single Sign-on and click Save. 

c. Select Requisite Provider (Oracle Internet Directory) and click Edit. 

d. Select Trusted, click Save, and restart all components. 

Top 
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Known Issues  

Re-deploying to WebLogic 8.1.x 

Using Hyperion Configuration Utility to re-deploy an existing web application to WebLogic 8.1.x 
does not work properly. A workaround is to first un-deploy the web application using the 
application server admin console, and then use Hyperion Configuration Utility to deploy the web 
application fresh.  

Calling LCM’s utility.sh 

LCM’s utility.sh is called from inside Reporting and Analysis’ defined LCMUtility.sh script 
and always from a pre-specified location. To avoid this, do not run utility.sh outside the bin 
folder. 

Dashboard Development Services 

Evaluation toolbar tooltips do not display  

Evaluation toolbar tooltips in Dashboard Architect do not display due to UniToolbox limitations. 
[1-18574904]  

Tables that are manually added are not recognized by the Build Dashboard 
frame in the Webdash dashboard  

Webdash only recognizes embedded section shapes that have names in the form Chart1, 
Chart2, and so on, or Pivot1, Pivot2, and so on. The name 'Chart' applies to any graphical view, 
the name 'Pivot' applies to any tabular view. The number indicates which panel the object is 
placed in.  

If a dashboard is built by using drag and drop in Interactive Reporting Studio, then the names 
generated by Interactive Reporting are incorrect for results, tables, and reports, and Webdash 
cannot recognize them. To edit these dashboards in Webdash, modify the generated names to 
conform to names that Webdash expects. [8-518653981]  

Incorrect selection behavior in Dashboard Studio Optimize: Move Filters 
dialog box  

Incorrect selection behavior in Optimize due to UniToolbox limitations.  [1-293723427]  

Vista: Title Bar text on all DDS modules appear garbled  

Text on the title bar of Dashboard Development Services tools appears doubled up or ghosted 
when using Windows Vista. To resolve this, change the Windows theme to 'Windows Classic'.  
[8-578258006] 

Wizard steps are not Unicode enabled  

Dashboard Studio wizard steps are not Unicode enabled. [1-218574924]  

Financial Reporting  

Exporting financial Reporting reports to Microsoft Office 2007 results in a 
warning message 
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When opening a Financial Reported exported report in an Office 2007 program (Microsoft Excel, 
Word or PowerPoint), the following warning is shown: 
"The file your are trying to open, <filename> is in a different format than  
specified by the file extension. Verify that the file is not corrupted and  
is from a trusted source before opening the file. Do you want to open the  
file now?"  
This warning notifies users that although the file has an Office extension  
(".xls", ".doc" or ".ppt"), the content of the file is different from  
the expected (native) Office format, since Financial Reporting reports are generated in an 
MHTML format when exporting to Microsoft Office. [9092271] 

Batch Bursting with certain functions runs the batch only for the parent  

When bursting a batch using the Children Inclusive or Descendents Inclusive functions, the 
batch is executed only for the parent member. To burst a batch to include the parent and 
children, or the parent and descendent members, select the member and children of the 
member, or the member and the descendent of the member, in the Member Selection dialog 
box.  [8-524084691]  

"Respond to Prompts" is disabled within Batch Editor for Imported Batch, 
even though it has Prompts  

When importing a batch containing prompts, the reports and books referenced by the batch 
should either exist in the repository or be imported before importing the batch. [8-568717103]   

In Batch Bursting, the FinancialReportingObjectDescription() function is not 
working  

When creating a batch to burst, do not use the <<FinancialReportingObjectDescription()>> 
function to create folders unless the descriptions exist and are unique. [8-526287081]  

The choice of colors on Vista is less than in Windows XP, 2000, 2003 

The chart color choices are limited when designing reports on a workstation with the Windows 
Vista operating system. Therefore, we recommend that reports designers create and design 
reports using a Windows XP workstation.  [8-568972261]  

Unable to browse App/DB (Look up) for SAP data source connection 

The data source lookup for Financial Reporting on the web fails for SAP and HFM data sources if 
APS is enabled for Essbase reporting. [8-627853953] 

Cannot run Essbase reports after running SAP reports as a different user  

When running an Essbase report after running an SAP BW report with user credentials that 
differ, the Essbase report returns "The datasource connection could not be found". To resolve 
this issue, log out and log in again. [1-464242475]  

FireFox: Application and database icons do not correctly appear in the 
database connection properties 

The images within the icons are off center. This does not affect the functionality in any way. [1-
237864041]  
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SAP reporting is not supported on HPUX Itanium when WebLogic is used as 
the application server 

Reporting against SAP BW data sources is supported for Web Application servers running on 
HPUX Itanium which support 64bit mode Java including Tomcat and WebSphere. [8--
571762156]  

Imported objects with illegal characters must be renamed before using them 
in Workspace  

Special characters (for example, *, ?, \, /, :, ') cannot be used in file names or paths in 
Workspace. You can, however, import Financial Reporting objects whose file names or paths 
contain these characters. This is allowed because reports created in previous releases may 
contains these characters in their names/path.  [8-511823361]  

Export and import of batch schedules and user POV's is not supported with 
Lifecycle Management  

Financial Reporting user POVs and batch schedules cannot be exported or imported using this 
release of the Artifact Life Cycle Management utility. [8-508433728]  

Online help for new functionality does not display in localized instances  

For Batch Bursting new functionality (for example, Preview Bursting List or PDF Attachments), 
selecting Help in localized instances returns a 404 Page Not Found error. [8-521838870]  

User POV lookup fails for HPUX (IA64) for WAS (Java 1.42) 

When Web Analysis or Financial Reporting is deployed to an Application Server that runs 64-bit 
mode (for example, Java 1.4.2.x, WebSphere 6.0), the Java argument -noverify must be 
passed. 

To pass the Java argument –noverify: 

1. From the WebAnalysis or Financial Reporting WebSphere profile/bin directory, invoke 
wsadmin.sh. 

For example: 

cd BIPLUS_HOME>/AppServer/InstalledApps/WebSphere/6.0/<WebAnalysis| 
FinancialReporting>/profile/bin./wsadmin.sh 

2. Create a variable called jvm to store the ID of the JavaVirtualMachine element for the correct 
server (WebAnalysis or FinancialReporting). 

For example: 

wsadmin>set jvm [$AdminConfig getid /Server:WebAnalysis/JavaProcessDef: 
/JavaVirtualMachine:/] 

(Replace /Server:WebAnalysis as needed.) 

3. Assign the value -noverify to the genericJvmArguments element. 

For example: 

wsadmin>$AdminConfig modify $jvm {{genericJvmArguments "-noverify"}} 

4. Save the changes. 

For example: 

wsadmin>$AdminConfig save 
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5. Restart the Web Analysis or Financial Reporting Web applications. [8-576179191]  

For user-defined lists, Current POV and Prompt functions should not be 
available for selection  

These two functions are not supported when creating user-defined lists in Member Selection. 
[8-511707911]  

Cannot see Substitution Variables if they contain quotes ("") 

Financial Reporting does not recognize surrounding quotes in Essbase Substitution Variables 
(SubVars). If there are SubVars with surrounding quotes that are required for Essbase calc 
scripts, they will need to be replicated without quotes for Financial Reporting to see them. 
SubVars can be more easily maintained with Essbase MaxL scripts. [1-400012131]  

Using the Essbase driver and Advanced Member selection with the NOT 
operator does not work correctly  

When using the native Essbase driver against an Essbase data source, using Advanced Member 
selection with the NOT operator includes members in the NOT condition. This issue does not 
occur when using the EDS/APS driver. [1-14NG86]  

Searching for Members with spaces in the name on the Web 

On the Web, searching for Members with spaces in the name does not work for Financial 
Management and Planning data sources. [8-623771881] 

Expansions do not collapse when there is more than one Reporting and 
Analysis portlet on a page  

Reports that use expansions may not refresh properly when viewed as a portlet. [8-
623083191]  

When using Vista for a client operating system, a report's Print Preview dialog 
box appears behind the Financial Reporting Studio 

When performing Print Preview from the Financial Reporting Studio running on a Windows Vista 
client workstation, the Print Preview output is displayed in the background, behind the Financial 
Reporting Studio window. There is a windows registry value that can be modified to fix this 
behavior. Contact Technical Support for detailed steps required to reset this registry value. [8-
567084722] 

Planning Server is listed in Related Content setup window 

When setting up Related Content in Financial Reporting Studio, a Planning Server is listed in 
Related Content setup dialog box. This Planning Server should not appear. 

Support running of Financial Reporting services using non-system account  

By default the Windows services created for Financial Reporting services and web applications 
will be configured to run using the 'Local System account'.  

To manually configure the Financial Reporting Windows services to run using a named user 
account: 

1. Create a new user such as FR_user. 

2. Make the new user a member of the local Administrators group. 

3. (Optional) Grant the new user 'Log On As A Service' right (granted automatically in step 5). 

4. Open the Windows Services control panel applet. 
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5. Edit each of these Financial Reporting Services, in the Log On tab change the 'Log on as:' 
option from 'Local System account' to 'This account', and specify the new user's credentials: 

 Financial Reporting Java RMI Registry (HyS9FRRMI) 

 Financial Reporting Print Server (HyS9FRRMI) 

 Financial Reporting Report Server (HyS9FRReport) 

 Financial Reporting Scheduler Server (HyS9FRSched) 

 Financial Reporting Web application (HyS9FRWeb) [8-605072067]  

On SAP, searching by description does not return the correct members  

When using SAP as a data source, you must search for members using the member name, not 
the description. If you search for members using the description, the members returned are not 
correct. [8-511413131] 

Expansion in SAP grid with Calculated / Restricted keys fails 

Expansions are supported only on rows for reports accessing an SAP BW data source with 
Calculated / Restricted keys. [8-509015627] 

Unable to burst batches against SAP data sources  

Batch Bursting is not supported for reports using SAP as a data source. [1-435805360] 

Unable to burst batches against MSAS data sources  

Batch Bursting is not supported for reports using MSAS as a data source. [1-435805277] 

Some jsps fail if the path length is > 256 characters and installing under a 
non-default directory 

Some jsps will fail if the path length is greater than 256 characters. This could happen when 
installing under a non-default directory. The workaround is to move the directory closer to the 
root directory to decrease the path length. [1-216006001]  

Firefox 1.5 displays the Help > About dialog box behind any opened PDF  

When using Firefox 1.5 to view the Reporting and Analysis Help About dialog box when a PDF 
report is open, the Help About dialog appears in the background and cannot be dismissed. [8--
504787516] 

Firefox displays an Error 500 message when a PDF report is run after 
changing the POV  

In Firefox, an intermittent error message is displayed when changing the POV, but the report 
runs successfully. In addition, when scrolling through a report, it may not refresh properly. [1-
175866021]  

Sorting considerations when using auto calculations on multiple dimensions 

Since the outermost layer of an auto calculation is the grand total of all rows in the calculation, 
sorting it is not supported. Sorting on the outermost layer when auto calculations are enabled is 
ignored. In addition, if you have auto calculations on more than one layer and select Sort, you 
must sort on all the heading layers (except the outermost layer) which have auto calculations. 
[3-373014]  



Reporting and Analysis Release 9.3.1 Readme 

15 

Charts disappear if the chart title contains an apostrophe  

If you enter a chart title that contains an apostrophe, when you preview the chart, it is no 
longer displayed. The workaround is to not use apostrophes in chart titles. [1-113528100]  

"Suppress if missing" incorrectly suppresses existing data on a dynamic 
account  

The "Suppress if missing" option incorrectly suppresses existing data on a Hyperion Financial 
Management dynamic account when the following conditions exist:  

� The POV is set on a dynamic account 

� A custom dimension is in a row with more than nine members selected 

� Only the "Suppress if missing" option is selected  

� Data query optimization is set on the data source server  

To work around this issue, do one of the following:  

� Set data query optimization to the Report server 

� Make sure there are less than 9 members selected in the row  

� Instead of using basic suppression options, write advanced options to suppress the missing 
values [3-376086] 

Text rows do not repeat on the next page via PDF output 

When a text row is inserted below the column dimensions, the text row (row 1) does not repeat 
on any page after page 1. However, the column dimensions text headings do repeat on all 
pages. This is also true for text columns. If a text column is inserted next to the row 
dimensions and the report is more than one page wide, the text column is displayed only on the 
first page. [3-24826]  

In the Dimension Layout dialog box in Financial Reporting Studio, if all 
attribute dimensions are included in the grid (row, column, or page), the 
Attribute box disappears  

Perform any of these tasks to work around this issue:  

� Create a new grid. The dimensions are all available.  

� Create a new report, then a new grid.  

� Create a new attribute dimension, then open the original report. Note that the box is now 
available and contains the new attribute dimension. [1-224574471]  

Row & Column Templates Column template fails to inherit formats  

When using row and column templates, inherit formatting can only be applied to one axis, 
either rows or columns.  [1-201320860]  

Infrastructure 

In Firefox, processing an Interactive Reporting document after the session 
expires prompts you to log on, despite specifying credentials  

If you encounter this issue, save the Interactive Reporting document file to a disk and then 
reopen it. [1-167378933]  
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Keywords are not exported for shortcuts 

Keywords are not exported for shortcuts. You can assign keywords manually after the 
importing. [8-530755508]  

To enable logging on the EI engine, add the log4j.properties file to the 
BIPlus/lib  

[8-526331547]  

For artifact promotion, the source and target systems must be same the 
version  

When promoting Reporting and Analysis artifacts, the Reporting and Analysis release installed 
on the source system must match the release installed on the target system. [8-525536330] 

Supported releases for Reporting and Analysis artifact promotion  

Reporting and Analysis artifact promotion is not supported for releases earlier than Release 9.3. 
[8-525536278]  

Ownership is not imported for Financial Reporting artifacts  

For Financial Reporting artifacts, the user who runs the import utility is displayed as the owner 
in Explorer. The owner in the source system maintains implicit full control of the artifact. [8-
521279336]  

Message in 'flag as an exception' text field is not exported for Interactive 
Reporting files (versions section)  

For Interactive Reporting files, text in 'flag as an exception' textbox is not exported. You can 
manually set the message after importing. [8-518631886] 

Errors may occur when using the Artifact Life Cycle Management utility to 
export large content  

Out of memory errors may occur when exporting large documents or large numbers of 
documents from an application to the file system. To avoid these errors, perform these steps 
before promoting artifacts: 

1. Increase the maximum Java heap size for Common Services. 

In startCommonServices. bat or startCommonServices.sh, change set BP_MAXHEAP=-
Xmx250m to set BP_MAXHEAP=Xmx1000m. 

2. Restart Common Services.  

3. Increase the maximum Java heap size for the Artifact Life Cycle Management utility. In 
utility.bat or utility.sh, add "Xmx1000m" as a Java option. [8-513845201]  

No warnings are provided when disk space is running low 

[8-520734737]  

SQR Production Reporting and generic job file names cannot be defined in a 
different language than in the Operating System where the Job Service 
resides  

Hyperion currently supports native file names for SQR Production Reporting and generic jobs in 
the same language as the language settings of the operating system where Job Service is 
deployed. Ensure that your operating system shell default encoding is the same as the default 
file encoding JVM property for your configuration.  [1-115106075]  
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During migration, the error message COMMON_SessionNotExists:0 is 
displayed intermittently 

If you receive this error, restart the Migration Utility and continue. [1-168899341]  

Single sign-on to HFM from Workspace URL prompts user with login page 
when it shouldn't  

When attempting to launch Hyperion Financial Management with single sign-on from a 
Workspace URL, you are prompted with a login page instead of being directed to the Hyperion 
Financial Management Workspace without prompting. 

The workaround is to URL encode the parameter value to extUrl (extRedirectForm.html). To do 
so, load an HTML page and redirect to the extRedirect command, using a form to post the 
extUrl to the extRedirect cmd: 

<html> 
<body onload="document.forms[0].submit()•">"> 
<form method=post action="http://sprig:19000/workspace/browse/extRedirect"> 
<input type=hidden name=extUrl value="http://reports-
js/hfm/Logon/HsvLogon.asp?sso_token=$SSO_TOKEN$"> 
</form> 
</body> 
</html> [1-180623171] 

Unable to link from the main page to another page on UNIX servers with 
secure SQR jobs  

If you have an SQR job that uses SmartCuts in HMTL output and that is linked to another HTML 
output page, the report and reference link names must be identical. For example, the names 
must be case sensitive. [8-577224421]  

Unable to run SQR Production Reporting jobs with parameters after upgrading  

After upgrading, make sure that AutoDetectUnicodeFiles=true in the sqr.ini file. This value is 
set to true for clean installations, but old installation could have settings that differ. Refer to the 
documentation on ENCODINGFILEINPUT Job Service parameter for more details. This applies to 
all 9.x releases. [1-250250871]  

Smart View requires Ghostscript for importing SQR Production Reporting jobs 

For Production Reporting jobs, Ghostscript must be installed and <gshome>/bin must be added 
to the system PATH. 

On UNIX, add <GSHome>bin to the PATH in: 

setenv.sh under <BI+ Home>/bin/SQR/Server/dbtype/bin 

On Windows, add <GSHome>bin to the PATH in: 

set_common_env.bat under <BI+ Home>/bin 

Installation and Configuration 

Unable to preserve repository if configuration installed in the new location  

You cannot make a new installation on another computer and point to the same repository and 
expect the repository physical files to be available. If the intention is to move the repository 
from one computer to another, contact Customer Support for assistance. [1-403597352] 
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On UNIX systems, for ODBC/ODBC (DB2) connections, only tables owned by 
the user are downloaded  

This is caused by a performance option in the configuration of ODBC data sources when using 
DataDirect. To retrieve all tables, in the ODBC.INI file (located in 
HYPERION_HOME/common/ODBC/Merant/5.1), set UseCurrentSchema to 0 
(UseCurrentSchema=0). Alternatively, the line could be removed as it is an optional property.  
[8-507929081] 

Cannot use the same installation destination folder when upgrading from 8.x 
to 9.x releases  

The installer does not permit you to choose an 8.x installation folder as the installation folder 
for 9.x; however, if you manually move the vpd.properties file on the computer, the installer's 
check fails, and the installer no longer prevents you from choosing an 8.x installation folder. [1-
89729701] 

Installation fails on UNIX if environment variable values include a backslash 
character  

Before running the installation on a UNIX system, ensure that no environment variables contain 
a backslash character ( \ ) in their values.  [1-160425771]  

Apache fails to start without the Apache/2.0.52/logs directory  

For WebLogic 8.1.5 and higher, you must have the following folder: 

<HYPERION_HOME>/common/httpServers/Apache/2.0.52/logs  

If you do not have this folder, you must manually create it. 

In UNIX, create the logs directory as symbolic link in: 

<HYPERION_HOME>/logs/apache [8-596291473] 

Unstable behavior of Reporting and Analysis Web applications on Oracle 10g 
application servers 

Deploying Workspace to an Oracle 10.1.2 Application Server can produce unstable results 
unless the WebCache component is installed along with Application Server and Web Server 
components during OAS10gR2 installation. [8-593373737] 

Financial Reporting and Web Analysis are not able to connect to HFM if they 
are installed before the HFM ADM driver 

To work around this issue, edit the service definition(s) in the Windows registry: 

1. Start the Windows registry editor, regedit.exe, as a user with Administrator privileges.  

2. Open the registry value: HKEY_LOCAL_MACHINE\SOFTWARE\Hyperion 
Solutions\<PRODUCT>\<SERVICE>\Env1\PATH, substituting <PRODUCT> and <SERVICE> as 
needed for Financial Reporting and Web Analysis, respectively. 

3. Append <HFM_HOME>\Common;<HFM_HOME>\Client, substituting <HFM_HOME> with the actual 
location where the HFM ADM Driver is installed. 

4. Restart Financial Reporting and Web Analysis services.  

Note: This issue affects new installations, only. Upgrade installations are not affected. [8-
619586925] 
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Creating NameTrans Entries for Static Workspace Content 

In the Hyperion Reporting and Analysis – System 9 Installation Guide for UNIX, in the 
"Manually Deploying into Sun Java System Application Server Enterprise Edition 8.1 05Q4" 
chapter, page 166, "Create NameTrans Entries for Static Workspace Content": 

replace: 

NameTrans fn="pfx2dir" from="/InsightInstaller" dir=<BIPLUS_HOME>/ 
AppServer/InstalledApps/workspace_static/zeroadmin/component/Insight" ObjectType 
fn="force-type" type="application/octet-stream" Service fn="send-file" 

with: 

NameTrans fn="pfx2dir" from="/InsightInstaller" dir=<BIPLUS_HOME>/ 
AppServer/InstalledApps/workspace_static/zeroadmin/component/Insight" ObjectType 
fn=type-by-extension ObjectType fn="force-type" type="application/octet-stream" 
Service fn="send-file" 

Interactive Reporting 

Data Filters: An error occurs when attempting to disable dimensions if 
Show/Hide Filters are applied 

If Show/Hide filters are applied to a grid, disabling the dimension member in the Member 
Selection dialog box causes an error message stating: “Dimension signature mismatch in 
function [EXCEPT] or [INTERSECT] on line [3]”. [8-627686525] 

CubeQuery/Show As Chart: In Essbase cubes with non-unique members, 
duplicate members of the same Generation are treated as one member in the 
chart 

[8-627619436] 

Some fact cells with different number formats in the grid are cut in the 
exported documents 

Some fact cells with different number formats in the grid are cut in the exported documents for 
all valid formats even if they were auto-sized. [8-626869471] 

CubeQuery/Thin Client Help: In Query Options, the Suppress Missing Row 
setting is enabled by default, however, the help contains incorrect 
information that this option is disabled by default 

[8-626186466] 

CubeQuery: Double-clicking collapses descendants only for one member per 
dimension  

Double-clicking on members with appropriate member selections made collapses descendants 
only for one member per dimension. [8-625739001]  

During publishing, disabled selectors become enabled 

When publishing Interactive Reporting jobs containing CubeQuery, disabled selectors become 
enabled in Job Parameters before running and scheduling. [8-625482071] 

CubeQuery: Aliases are not displayed in the Date-Time Series dialog box 
inside member selection 

When alias tables are used, aliases are not displayed in the Date-Time Series dialog box inside 
member selection. Only member names are displayed. [8-625269291] 
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CubeQuery: Critical error on attempt to process the query when asymmetric 
drilling is applied and Date-Time Series (DTS) type is changed 

If asymmetric drilling is applied to members with a DTS selection type, and the type is changed 
to another one, selectors in Member Selection dialog box are not updated according to changed 
type. An error message “Unknown member used in Query” appears when attempt to process 
the Query. [8-625206634] 

CubeQuery/Thin Client: Right-click menu in Content pane is not updated with 
changed Suppress options in the Query Options dialog box 

Process the CubeQuery to synchronize Suppress options in the right-click menu and the Query 
Options dialog box. [8-578578461] 

CubeQuery/Thin Client: It is impossible to select member labels with the 
shift+arrow keys 

[8-578357312] 

CubeQuery: Essbase metaread filters restrictions are still displayed in Member 
Selection  

If metaread filters restrict you from viewing specific members, you will still see all members in 
the Member Selection dialog box when opening a BQY file. [8-575990259] 

CubeQuery: Unable to process section connected to application/database with 
no trailing"$&" characters in name  

[8-554439571] 

Embedded report is not scrollable in Autosize mode in Dashboard section  

When a report section is embedded using the Autosize option in Dashboard, only the first page 
is displayed. The scrollbar does not appear. Unchecking the autosize option will make the 
scrollbars work. [8-557114431]  

ListBox flicker with Select() method or state change  

Certain activities may make the listbox flicker in MSIE6, specifically Select() actions. [8-
553442521]  

Interactive Reporting Dashboard Home toolbar button is always disabled  

Dashboard home must be explicitly set in Interactive Reporting Studio or Interactive Reporting 
Web Client for it to be active in the Workspace client. [8-511494011]  

Dashboards that contain large numbers of shapes generate "unknown 
exception" errors  

Using more than 1021 shapes in a Dashboard section is not supported. [8-507045281]  

The JavaScript string.search function fails to find matches  

[1-368493881]  

PreloadContent() method improperly activates section, mismatches 
dashboard and catalog sections  

The preloadContent object model method should be exercised carefully, following these 
recommendations:  
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� Invoke preloadContent only after the point at which URLs of the embedded browsers are 
determined.  

� All embedded browsers of the preloaded Dashboard are displayed even before that 
Dashboard is activated.  

� Invoke preloadContent only for a single Dashboard that users visit. This is recommended to 
avoid overloading the browser, which could cause the negative performance. [1-
213080681] 

Oracle 11g client installation does not allow DAS to connect to a database 

To connect to a database, use one of the following methods:  

� Start DAS from the batch file (startIRM.bat), or from Services panel (Hyperion S9 BI+ 
Interactive Reporting Service) as the network user. (This may have adverse effect on 
Windows authenticated connections for MS OLAP and MS SQL Server.)  

� Add PATH and ORACLE_HOME variables, pointing to the Oracle 11g client install, to “User” 
Environment Variables and start DAS as normal – as Local System. [8-610594111]  

Configuring ports for Interactive Reporting Services 

The following simplified procedure describes alternative ways to set up ports for Interactive 
Reporting Services. This procedure can be used instead of the one in the Administration Guide.  

Specify the comma separated ports range in the following files for the Interactive Reporting 
Service:   

<BIPlus>/common/config/BIprocessmonitor.properties For IR Data Access Service  
<BIPlus>/common/config/DASprocessmonitor.properties  

Example: PORT_RANGE=1811,1812  

Make sure that the number of ports specified is the same as 
MAX_NUMBER_OF_MANAGED_SERVICES. The default value is 2. [8-567864885]  

Cannot use Teradata 3.05.00.00 drivers for UNIX with Hyperion Interactive 
Reporting Data Access Service  

Because of incompatibilities related to Unicode character representations, Hyperion Interactive 
Reporting Data Access Service does not function with the Teradata 3.05.00.00 drivers for UNIX. 
Using the Teradata 3.05.00.00 drivers with Hyperion Interactive Reporting Data Access Service 
causes unpredictable results. [8-509924381] 

Access 97 MDB files should be converted to Access 2003 format  

Access 97 is non-Unicode and should be converted to Access 2003 format when used as a data 
source for Interactive Reporting. [1-293557831]  

CTLib/Sybase connection is not supported by Interactive Reporting  

CTLib is not supported due to insufficient Unicode support. Use an ODBC connection with 
supplied Data Direct ODBC drivers. [1-179915581]  

Columns have no data type when using metadata  

To fix the issue for a meta OCE connection: 

1. Select Tools > Connection Manager.  

2. Select the OCE and click Modify.  
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3. In the Meta OCE Wizard, click Edit.  

4. In the Metadata Definition window, select the Columns tab and enter the following SQL for 
the Byte Length: 

(CASE WHEN ColX.CharType = 1 AND (ColX.ColumnType = 'CF' OR ColX.ColumnType = 
'CV') THEN ColX.ColumnLength*2 ELSE ColX.ColumnLength END) column_length  

5. Click OK and Finish and save the Interactive Reporting database connection file (OCE).   

6. Delete the table in the Content pane, and delete the request items in the query.  

7. Add the table from the catalog and create the query. [8-557436977] 

In Workspace, switching from CustomValues to ShowValues limit in a Query 
section causes the browser to hang  

If the dialog box becomes inactive, click somewhere on the borders (area outside of the limits 
area) to reactivate it. [1-171501191]  

Jobs fail with an Essbase error when OLAPQuery and CubeQuery sections use 
the same data source 

When running a BQY job that contains an OLAPQuery and CubeQuery section using the same 
data source OCE, the job fails with Essbase error message 1030749. [8-626892347] 

Cannot import Excel saved in Office 2007 format 

The Office 2007 format of Excel documents is not supported for importing in Interactive 
Reporting. Save the document in old Excel formats, and Interactive Reporting will be able to 
import the XLS documents. [8-615988115] 

Some menu items may not be visible on IE7  

In internet security zone settings / advanced, check 'Allow scriptinitiated windows without size 
or position constraints'. In order for menus to size and position properly, the permission "Allow 
scriptinitiated windows without size or position constraints" must be granted. 

Microsoft has added the following option to IE for Windows XP SP2 to enhance browser security. 
More details can be found on Microsoft technet. http://technet.microsoft.com/en-
us/library/bb457150.aspx [8-614839821]  

Interactive Reporting core services and Interactive Reporting Manager (IRM) 
use dynamically allocated ports 

Interactive Reporting Core Services use two dynamically allocated ports, which cannot be 
configured within defined range. Interactive Reporting Manager uses one such port. There is no 
way to specify exact port number or range of ports for these ports. This issue will be corrected 
in future releases. [8-599204489] 

Unable to install Insight on a Vista machine  

A workaround is to bypass Vista’s UAC (User Access Control). With UAC enabled, Vista always 
runs the executables with restricted rights (even if users have administrative rights).  

You can disable UAC in the following ways: 

� Completely (http://vistaclues.com/?p=9) 

� For a particular application (http://vistaclues.com/?p=23) 

� Only for one run (http://vistaclues.com/?p=21 ) [8-580617471] 
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Saving Interactive Reporting Job output to the repository with Web Client or 
zero client fails 

Open Interactive Reporting job output in zero client or Web Client and then save/save as to 
repository without changing the file name fails. Change the name of the file during save so that 
it does not clash with existing job output name. [8-542839093]  

Image handling for Interactive Reporting documents is changed in 9.3  

When an Interactive Reporting document (BQY) is created and saved using 9.3.x releases, all 
images are saved in a centralized format (the Resource Manager). As a result, the images 
cannot be read or displayed in prior releases of Interactive Reporting. This is because the 
relocation and rationalization of the images are not understood by releases prior to 9.3.x. The 
exception is images from a document saved in a pre 9.3 Release, which have been referenced 
once: not copied, merged or duplicated, that is, placed in Dashboard or Report workspace as a 
Picture graphic in traditional fashion.  

To retain compatibility with earlier releases, you can run the RevertImageResources script. This 
script provides a facility to undo the relocation and image merging, and thereby return the 
Interactive Reporting document to the pre 9.3 Resource Manager format. This script is included 
with the 9.3. release of Dashboard Development Services. It can also be downloaded from the 
Hyperion Developer Network. This script can only be used on the desktop, and not in 
Workspace, as it relies on the COM feature of Interactive Reporting Designer.  

Certain new features make documents ineligible for conversion to the nonResource Manager 
format. For example, if a 9.3 Interactive Reporting document has Bubble and Scatter charts, 
then these are lost when the Interactive Reporting document is opened in the older version of 
Interactive Reporting Studio. [8-527453411] 

In Firefox, you cannot open a locally saved Interactive Reporting document 
that contains double byte characters in its file name  

Firefox does not invoke Interactive Reporting Web Client if the file name contains characters 
from a code page that differs from the system code page. You cannot use multilingual file 
names in Firefox. The file names must match the system code page. [1-264647661]  

Korean and Chinese custom date and time formats (beginning with [$F400] 
or [$412] are not supported for import  

Several custom Korean and Traditional Chinese date and time formats (beginning with [$F400] 
or [$412]) are not supported and do not import correctly from Excel.  

The following formats are available under the Time/Date category in Excel like standard formats 
but are custom formats: 

Korean: 
[$F400]h:mm:ss AM/PM 
[$412]AM/PM h:mm;@ 
[$412]AM/PM h:mm:ss;@ 
[$412]yyyy""m""d AM/PM h:mm;@ 
[$412]AM/PM h" " mm" ";@ 
[$412]yy""m""d AM/PM h:mm;@ 

Chinese (Traditional): 
[$F400]h:mm:ss AM/PM  

In the above formats, the AM/PM part is not displayed with hieroglyphs as it does in the original 
Excel file. [1-250056731] 
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Firefox error occurs when turning on Data Layout in Workspace 

When using FireFox 1.0.7, the error "BqHdl.handleRequest fails: content.BI_postHandleRequest 
is not a function" is displayed when attempting to turn on Data Layout for Results, Table, Pivot, 
or Chart sections in Workspace. You get this error only once in a Workspace session. [1-
242597311] 

Cannot drag and drop locally saved Interactive Reporting documents that 
differ to the same browser when running Interactive Reporting Web Client in 
Firefox  

You must log off and log on again for the new version to be used. [1-168267494]  

Interactive Reporting locale preference date formats do not change until next 
session  

Changes to locale preferences do not take effect until the user session is ended and restarted. 
[1-128991630]  

Unable to install Interactive Reporting Web Client on Vista when server uses 
revoked SSL certificates 

Default IE+ security on Vista has 'Check for Server Certificate Revocation' option checked. 
Uncheck this to proceed with the installation. [8-575779363] 

Unable to run BQY jobs for some derived queries 

If an Interactive Reporting document has derived query: 

1. Open the document in Interactive Reporting Studio, select the Derived Query section, and 
save the document. 

2. Republish or update the document in the repository. 

3. Run the job. [8-626781632] 

Need to update irmconfig.xml to start more than one Interactive Reporting 
Job Service on a single host 

To run more than one IRJobService, comment out <PROPERTY name="PORT_RANGE" 
value="6815"/> in the IRJob section of <BIPLUS>/common/config/irmconfig.xml [8-
567654517]  

OS patch required to start Interactive Reporting services on AIX  

The following AIX patch (for both 5.2 and 5.3) is a prerequisite for Interactive Reporting 
services: 

November 2005 XL C/C++ Enterprise Edition V7.0 for AIX PTF 

See http://www1.ibm.com/support/docview.wss?uid=swg24011025. [1-227641714] 

Naming a control "ActiveSection" causes unexpected contention with the 
ActiveSection Name property 

Using Interactive Reporting Object Model reserved keywords (such as ActiveSection for naming 
controls) can result in unpredictable behavior. Such usage is not supported by the product. [8-
533289835] 
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Using Euro or other special characters in control names for the onClient script 
causes a JavaScript error in Workspace  

Dashboard control names must not contain these characters: %,#,&,*,!,€,\,/  [1-218463891]  

Printout method does not execute in documents that contain Alert after 
Printout()  

Using the Alert method after the Printout() method prevents the Printout method from 
executing in Workspace. [1-172133795] 

Mandatory ExporttoStream arguments are shown as being optional in script 
editor description pane  

The Interactive Reporting script editor description pane incorrectly indicates that all arguments 
for the ExportToStream method are optional. These three arguments are mandatory and must 
be supplied in order for ExportToStream to function: Filename, format, and datastreaming. [1-
106400589] 

IR/SAP BW and SAP GUI 6.4 provider: Unknown Error when dragging 
members from an alternate hierarchy 

Unknown error displayed when an individual member value is dragged into outliner from an SAP 
BW alternate hierarchy. This issue is specific to the OLAP Query section in an SAP BW data 
source and occurs only when using the SAP GUI 6.4 OLE DB for OLAP (ODBO) driver. [8-
623138343] 

Embedded content, help, and dialog limitations  

The following limitations apply to Interactive Reporting documents embedded in a dashboard 
through the Embedded Browser or Hyperlink controls:  

� Help is not available in toolbar or dialogs  

� Number Formatting option is not available  

� References subdialog of Computed Item dialog box is not available  

The same limitations apply when an Interactive Reporting document is referenced by a 
SmartCut URL that uses the get action (rather than get_withnav). [1-121202823]  

Export to PDF of pivot section cuts off right edges  

The issue is that the total side label width is wider than the Portrait settings. Reduce the 
number of side labels to decrease the width or change the page setup to Landscape and then 
export to PDF. [8-511893124] 

In Workspace, some Computed Item names do not display correctly in Data 
Layout 

Special characters that are not allowed in naming JavaScript's identifier or functions must not 
be used in column names and control names. For example, whitespaces, "|", "$", € (euro), 
reverse solidus (backslash) (same as half-width Yen & half-width Won). Using such characters 
in control names is not supported and can make document rendering useless in Workspace. [1-
117056011] 

In Firefox, the Interactive Reporting portlet command button does not 
execute a script when clicked  

This occurs only with Firefox version 1.5.0.3. Update to Firefox version 1.5.0.7 to automatically 
solve this problem. [8-516078409]  
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Interactive Reporting portlet uses default fonts that differ from the fonts used 
in Workspace 

In WebSphere portal, the fonts used in Interactive Reporting documents are changed to 
Verdana, which may cause clipping or overlapping of text. To fix this, use the Verdana font 
when creating documents, and modify existing documents to use the Verdana font. [1-
494521481] 

The functions in Function Categories, other than Aggregate Functions, are not 
supported by TimesTen 

Interactive Reporting products show more functions available than the TimesTen database 
supports. Only Aggregate functions are supported by TimesTen. [8-601444878]  

On UNIX, if LANG is not set to en_US, retrieving large BLOB images could 
cause Interactive Reporting Web Client to hang  

This issue occurs when retrieving data from a database using the DataDirect ODBC drivers on 
UNIX and Linux platforms only when the environment variable LANG is other than en_US. The 
workaround is to create a symbolic link: 

-s $HYPERION_HOME/common/ODBC/Merant/5.1/locale/en_US 
$HYPERION_HOME/common/ODBC/Merant/5.1/ locale/$LANG  

See http://media.datadirect.com/download/docs/odbc/readme/unixread.htm  

[8-516374921]  

Inserting a new query in Interactive Reporting Web Client may cause an 
invalid logon error  

Try processing again as a workaround. This issue does not happen if database credentials are 
provided in the database connection file or Query section. [1-274236113]  

Sybase IQ is not supported on UNIX  

ODBC Drivers must support UTF16. Sybase IQ ODBC driver does not support UTF16 on UNIX. 
Hyperion Interactive Reporting Data Access Service must be used on Windows for Sybase IQ 
data sources. [1-262593101] 

For ODBC/Teradata connections on Solaris, an error is displayed when 
entering correct login information after invalid login information  

When using version 4.0 of the Teradata ODBC drivers on UNIX platforms, make sure that 
CharacterSet=UTF16 is present under the data source in odbc.ini. [1-250538592] 

Interactive Reporting cannot connect to Red Brick on UNIX  

Red Brick is supported only on Windows for this release. [1-247297871] 

Exceptions occur in Workspace when processing local results or a derived 
query when the source query is removed  

In Workspace, deleting the main query section before switching to the derived query section 
may not clear the Request column items of the derived query. This is due to the "Partial 
document loading" feature. The workaround is to switch to the derived query section before 
deleting the main query section. [1-213453921] 
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Default number formatting is ignored by Timestamp columns that are dropped 
into Report Groups/Facts 

To fix the formatting, set the "Date" format equal to "Timestamp". Do this either for default 
formats going to Tools > Options > Default Formats > Numbers or individually for each 
problematic report group. [8-626322849] 

Report section XLS export does not check whether the destination file is 
locked and export fails  

Report section XLS export to an existing file does not check whether the destination file (which 
should be overwritten) is locked. XLS export does not occur in this case although the user is 
asked about file replacement. This is not an issue for Results or Table sections. [1-227444990] 

Alignment and Suppress Duplicates features do not work with BLOB columns 
in IR Studio/Web Client [1-464151264], [8-504698115] 

Header/footer is mapped to the dialog box font, but PDF export lacks double-
byte characters  

By default, headers and footers of Results, Table, Pivot, and Chart sections are mapped to the 
dialog box font, MS Sans. Because this font is not presented as a single file in the system, but 
as a series of fonts that may be used to show specific characters, the PDFLib can export only 
certain amounts of characters using the new export mechanism for multicode page PDF export.  

To avoid the lack of double byte characters in PDF export, change the Header/Footer font to 
Arial Unicode MS or Andale WT. [1-266728601]  

Cannot connect to a database using an Open Client/Sybase connection on 
Solaris due to missing locales  

Configure Sybase client locales to include the following: 

For Solaris and AIX: en_US.ISO88591  

For HPUX and Linux: en_US.ISO88591  

Sybase Client locales are in <Sybase Client Install Dir>/locales/locales.dat. [1-
95958211]  

Interactive Reporting Studio installer adds Essbase RTC path to ARBORPATH 
without removing old value [8-622814331]  

Migration  

User preferences are not migrated because of default report's long name  

For migration on a DB2 8.2 target system, it is highly recommended that you set up FixPak 8a 
(also known as Version 8.2 FixPak 1a). See the following URL to prevent string data truncation 
as described in JR20492: 

http://www1.ibm.com/support/docview.wss?rs=0&uid=swg24009543 [8-504736731]  

User's home folders are not synchronized with user preferences when the 
user name contains unsupported characters  

If a migrated user name contains unsupported symbols and is not synchronized with the user's 
home folder, you must the copy previous user's home folder content to the migrated user's 
home folder. [1-245569867] 
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Inconsistent results occur when using JDBC versus Host and Name migration 
methods  

You must use the latest Oracle 9.2.0.5 JDBC driver for the target Oracle9i repository. [1-
238593420] 

When migrating Hyperion Analyzer content, cannot connect to target DB2 8.2 
database using native JDBC drivers when source database is DB2 7.x  

Cannot connect to target DB28.2 database using native JDBC drivers when the source database 
is DB2 7.x. These JDBC drivers are supported for migration from DB2 7.x to DB2 8.y: 

� Source DB2 7.x db2java.zip type 2 driver > target DB2 8.y Hyperion supplied DD driver. 

� Source DB2 7.x db2java.zip type 2 driver > target DB2 8.y db2jcc.jar type 4 driver. [1-
176763528]  

Error is shown in console log if migrating an OCE into a directory without / at 
the beginning of the path 

The Migration Utility only supports absolute paths like /BCS_Jobs/default for default Jobs 
location for Broadcast Server and OnDemand Server migration. [8-516292771] 

BCS Job counting on Run Migration screen should correspond to chosen jobs 
on Content Filtering screen  

The total number of jobs used on the Run Migration screen does not correspond with the 
number of jobs selected to be migrated on the BCS Content Filtering screen. This value is 
always equal to the number of jobs at the Source system. [8-511078961]  

Unable to retrieve some folders using SDK 

Since the Common Services have a limitation on the number of fetched elements (100 
elements by default), the Migration Utility will not display more than 100 folders for BCS Job 
Mapping.  

To change this limit, pass the system property MCL.JDBCFetchMaxRowSize as a startup 
parameter to Common Services, for example: DMCL.JDBCFetchMaxRowSize=500. [8-
510301351]  

Majority of rows of the V7_SCHEDULELOG table are not moved  

If the source Portal 7.x or Performance Suite (HPSu) 8.x does not use the DB2  
database, but the target does use DB2, and some tables in the source database have long 
Unicode varchar values, then some rows from the source tables cannot be inserted in the target 
tables. An exception such as, “Character data, right truncation occurred” is displayed in the 
migration log. 

To resolve this issue, execute the following SQL statement for the target database for each 
varchar column with long Unicode values and repeat migration: 

ALTER TABLE [TABLE_NAME] ALTER COLUMN [COLUMN_NAME] SET DATATYPE VARCHAR  
([2*EXISTING_COLUMN_LENGTH]) 

For example: 

ALTER TABLE V8_SCHEDULELOG ALTER COLUMN ERRORMSG SET DATATYPE VARCHAR (500) 

[8-541197826] 
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Some user preferences do not migrate  

Some user's preferences such as default folder and folder for SQR do not migrate from HPSu. 
[8-615761688] 

Newly-implemented circular roles dependencies checker  

Although you can create circular dependent User Defined Roles in HPSu 8.x systems, the 
Migration Utility searches and removes such dependencies for 8.x roles as well as for groups, 
since they are not allowed in Shared Services. [8-608829365] 

Some connection details are not shown for Interactive Reporting connection 
files migrated from HPSu 8.x  

Interactive Reporting Database Connection details (such as Connection Software, Database and 
Host) are not shown in Workspace for Interactive Reporting connections (OCE files) migrated 
from HPSu 8.x to System 9. This does not affect the connection's functionality. To force details 
to be shown, download and manually republish the appropriate connections. [8-584242367] 

Migration Utility fails when Usage Tracking tables are in a different schema 
from the Repository  

Migration from HPSu fails if source Usage Tracking tables are in a different schema from the 
Repository. Before migration, you should manually create and fill the Usage Tracking tables 
using the SQLscripts supplied with the HPSu installation. [8-535630014] 

HPSu Owner for shortcuts and folders is not migrated  

For migration from HPSu, ownership information is not migrated for shortcuts and folders. [1-
170782011] 

On HPSu 8.1.2 migrations, authors of objects (files, folders) are not migrated 
completely  

Migrate HPSu 8.x before other products when the products that are all migrating to the same 
target have users/ groups with the same name. Another approach is to change names of such 
users/groups. In these cases the problem is not reproduced. [1-170004380]  

No check for circular group dependencies is activated if the Migration Utility is 
restarted  

When migrating from several HPSu source systems, after each migration process, close 
Migration Utility and run it again. Do not choose 'Restart Migration' button on the last migration 
step. [1-355760041] 

Incorrect behavior on Host Mapping screen if not all available hosts are 
mapped  

When migrating from HPSu, if not all the available hosts are mapped on Host Mapping screen, 
then when navigating between the migration steps, you can find that a not mapped host 
disappeared from the list of available hosts. To get all the hosts back, close the Migration Utility 
and run it again. [1-326022351] 

When Shared Services uses SSL, pre-migration tasks are required 

If Shared Services is protected by SSL, before running the Migration Utility, you must perform 
these tasks:  

1. Receive security certificates from Shared Services Application Server and all external 
authentication providers, which are registered in Shared Services and use SSL. 
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Use openssl s_client connect <HOSTNAME>:<PORT> and save the received certificate to 
the file system.  

2. Import certificates to $HYPERION_HOME/JRE (${JRE_HOME}/bin/keytool import keystore 
${JRE_HOME}/lib/security/cacerts file <CERTIFICATE_PATH> alias <ALIAS_NAME>) [8-
529486115] 

ActiveDocument.Sections formatting is lost in Text labels, when migrating 
from Release 6 to System 9  

Text labels with ''ActiveDocument.Sections" do not retain formatting when migrating from v6 to 
Hyperion System 9. [8-529107952]  

The Migration Utility does not check for illegal characters on the Objects to 
Migrate screen 

Some special characters are not allowed in Reporting and Analysis. To avoid incorrect Migration 
Utility behavior, do not use such characters when naming the default folders for placing OCE 
files and BQY jobs during migration. For complete list of illegal characters, see the Hyperion 

Reporting and Analysis Migration Utility Guide. [8-516292521] 

Circular dependencies checker works incorrectly when Portal is configured to 
use an external authentication system  

Circular dependency checker works incorrectly with external authentication systems. Remove 
circular group dependencies in your external authentication system before running the 
migration. [1-279242031]  

Write access to job outputs is translated to Full Control access regardless of 
the selected option  

For migrations from BrioONE or Portal, if the 'Translate to Modify' option is selected during 
migration to handle access control for Portal objects, users with write access to job outputs in 
source Portal 7 will have view access in System 9. This is because System 9 has no 'Modify' 
access level on job outputs. To work around this, either select 'Translate to Full Control' during 
migration, or manually assign the level of access to existing job outputs after migration. [8-
559818387] 

Default file permissions are set incorrectly for external users  

Default file permissions are set incorrectly for external Portal users. You should manually set 
default publishing permissions after migration. [1-249682261] 

Options for Prefix and Suffix do not work for external source groups created 
in the Native Directory during migration  

If the source system is configured to use an external authentication provider, but the groups 
from the source system are created in the HSS Native Directory, then the Prefix or Suffix option 
is not applied to the group name during the migration. [1-428165664]  

Reports Content migration from some Oracle repositories intermittently fails 

Hyperion Reports Repository Content migrations from some Oracle instances can fail if there is 
not enough memory available in Oracle pools. If this happens, increase the java_pool_size, 
large_pool_size, and shared_pool_size Oracle initialization parameters, and increase the 
total PGA memory size. [8-576380531]  
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Financial Reports do not display correctly after migration  

Some Financial Report objects (such as images and grids) are lost from the localized source, 
Financial Reports 7.x to System 9, by the Migration Utility after migration. This occurs when 
running on a machine with a locale setting different from the source system locale. To work 
around this issue, install the Migration Utility on the machine running the source system, or any 
other machine with the same locale setting. [1-428173991]  

The HTML format of migrated Portal SQR jobs output seems empty 

Use SmartCuts to view the HTML format of migrated Portal SQR job outputs. [8-631476711]  

Migration Option "DuserForDeletedUsers" is handled incorrectly 

The HPSu and Portal migration option "-DuserForDeletedUsers" is handled incorrectly by the 
Migration Utility. This option sets the owner on objects whose owner was not previously 
migrated. This issue does not affect object functionality - only owner assignment. To avoid this, 
use the source user's UUID instead of the user name. [8-615194076] 

Performance Scorecard  

Not able to load employees without specifying the initial field through HAL 
Adapter  

[8-535510127]  

JAVA_HOME variable not defined when starting up HPS running with Tomcat 
on HP Itanium 

In the startHps.sh file for Tomcat, change the parameter for JAVA_HOME from: 

JAVA_HOME=/home/hps/Hyperion/common/JRE/HP/1.5.0 

to: 

JAVA_HOME=/home/hps/Hyperion/common/JRE-IA64/HP/1.5.0 [8-579535221] 

Get a DataDirect driver java.lang.VerifyError at start up 

To avoid this error, rename the following three files located in the server/lib folder under 
Bea: 

wlutil.jar 

wlbase.jar 

wlsqlserver.jar [8-573454951]  

Upgrading from a 4.1.1 installation to a 9.3.1 installation causes an App 
server deployment failure during configuration 

[8-622884295]  

A Run Time Error message is displayed when the Notes symbol is selected in 
localized versions of Performance Scorecard Release 9.2.x  

The error is displayed in all localized releases of Performance Scorecard 9.2.x in the popup 
Scorecard details window (accessed by clicking the map element). This problem is fixed in 
Release 9.3 where the popup window has been changed to a Windows popup. [8-516025842] 
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A Run Time Error message is displayed when Edit is selected on the Initiative 
tab in the Chinese version of Performance Scorecard Release 9.2.x  

Do not select the Edit button on a popup for Conrad. This will be fixed in the next localized 
release. [8-516025817]  

Ensure that when HPS is installed as a service, it does not use the Windows 
SYSTEM account  

[8-608445291]  

Security Files are installed with world read permission 

[8-608445197]  

Security Risk warning is shown on UMC when accessing integrated product 
ACL page for the first time  

[8-623005171]  

SAP BW  

$HYPERION_HOME BIPluscommon/SAP/bin/explode.jar must be run as part 
of the Web Analysis configuration process for SAP BW connectivity  

[1-266682541]  

Unable to access SAP BW when the browser language is set to a language not 
installed on the SAP server 

[8-521867904]  

Export to Excel as “query ready” is not allowed for SAP reports  

SAP BW reports exported in "query ready" format to Excel cannot be queried in Excel, because 
Smart View does not currently support SAP BW as a data source. [1-14KS2V]  

Shared Services  

Application Naming Restrictions 

When managing Shared Services models and naming applications, you cannot use the forward 
slash (/), backslash (\), or double quotation (“) characters. All other alphanumeric and special 
characters can be used in application names. [8-514151218] 

Objects imported from Shared Services are not displayed until after you 
refresh 

After documents are imported from Shared Services, the documents are not displayed in the 
repository until View > Refresh is selected for the directory containing the imported documents.  
[1-93347204]  

Internet Explorer can crash with an error in MSHTML.DLL if some security 
fixes are installed 

If certain security patches have been applied to Microsoft Internet Explorer, the product can 
quit unexpectedly. The error message may refer to MSHTML.DLL.  



Reporting and Analysis Release 9.3.1 Readme 

33 

To resolve this problem, install the most current cumulative security update for Internet 
Explorer, or install update 923996. See 
http://support.microsoft.com/default.aspx/kb/923996/ for details. [8-509029251]  

New Document wizard closes unexpectedly when you do not have permission 
to access Interactive Reporting documents  

When creating Interactive Reporting documents with the New Document wizard, you can select 
a file to which you do not have access (such as a file imported by another user). If you select 
such a file, you get an error message that you do not have permission to access the document, 
and the New Document wizard closes. [1-172449278]  

Unable to open Microsoft Office files in a new window in Internet Explorer 
running on Windows 2003 server  

To open Microsoft Office files in a new window in Internet Explorer running on Windows 2003:  

1. Add Workspace URL to the trusted zone.  

2. Enable Automatic prompting for the downloads option for trusted sites.  

3. Disable Use Popup Blocker. [8-507224307]  

L1 German: Sorting is performed incorrectly according to Name and 
Description  

[1-122207501] 

Owner value is not displayed for files/folders in the Properties dialog box 

[1-121370645]  

Edit Permissions dialog box does not show arrows when first accessed in the 
session 

When the Edit Permissions dialog box is first opened, the arrows in the center of the dialog box 
are not displayed. The workaround is to close and reopen the Edit Permissions dialog box. [1-
170699851]  

Files cannot have ACLs or be Favorites for users without Reporting and 
Analysis roles  

Hyperion Financial Management and Planning users must have a Reporting and Analysis role to 
launch Hyperion Financial Management or Planning release 9.2 applications from within 
Reporting and Analysis. [8-536545961]  

SQR Production Reporting 

Chart is not displayed in report if placed in a Production Reporting Studio 
Group Summary section  

Workaround: 

1. Place the chart in the Query Summary section and process the report. 

2. In the report layout, move the chart from the Query Summary to the Group Summary.  

3. Process the report again.  

Now the chart will appear correctly for each group break. [8-513486144] 
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User Provisioning 

Users Directory does not display immediately  

It is possible to create a user's home directory structure using the ARU Import Utility, 
distributed as part of Reporting and Analysis.  

To create ARU import documents for the ARU Utility: 

1. Create ARU import document with following structure: 

<?xml version="1.0" encoding="UTF8"?> 
 <AnalyzerAdmin> 
<ModifyUsers> 
 <User LoginID="user_name1"/> 
 <User LoginID="user_name2"/> 
 <User LoginID="user_name3"/> 
</ModifyUsers> 
 </AnalyzerAdmin> 

Note that it is necessary to create the <User> tag for each newly created user for whom 
you want to generate home directories.  

2. Start the Reporting and Analysis WA Web application. 

3. Edit <BIPLUS_HOME>/common/config/ARUImport.properties to adjust ARU settings.  

4. Ensure that "ImportFile" property contains absolute path for ARU import document created 
on step #1).  

5. Run the ARU Import Utility against newly-created import documents using the 
<BIPLUS_HOME>/bin/ARUUtil.bat(.sh) script. 

Following the above steps causes the ARU Utility to create home directories for all users listed 
in the import document. [1-248516375] 

Web Analysis 

Adding and Web Analysis in Workspace uses different method authorizing 
data source alias controller 

The information about the Web Analysis preferences under Workspace that it uses specific 
setup for Alias controller to work: Web Analysis authenticates to the data source by passing ID 
and password directly, while Workspace prompts for data source password if it was not 
previously saved. [8478040] 

API has samples and documentation from Hyperion Analyzer 7.0.1  

Web Analysis Studio client API documentation and samples from Hyperion Analyzer 7.2.x still 
apply to Hyperion System 9. Contact Customer Support for the 7.2.x samples and 
documentation. This will be addressed in a future release. [1 - 235514371] 

Servers may be displayed as "null" in the Related Content dialog box  

The Add Related Content dialog box in Web Analysis Studio may display the Reporting and 
Analysis node in the Available list as "null on host:19000" instead of "Reporting and Analysis on 
host:19000" where host:19000 is the name and port number of a Reporting and Analysis 
server. [1-466501965]  
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Launching Related Content Link to Workspace from Web Analysis Studio fails 
when using SAP BW Security Provider  

When using the SAP provider, an HTTP GET request should not be used to pass the SSO_TOKEN 
because of size restrictions. The Related Content link created when using the SAP BW SSO 
Token is larger than maximum number of characters that can be written to Internet Explorer’s 
address bar, which causes the Related Content link to fail because it is incomplete. This is not 
an issue when using Firefox. [1 - 268360911] 

Unable to see related content entries in Web Analysis Studio  

To enable related content in Web Analysis:  

1. Ensure that Workspace is running.  

2. Open the Web Analysis properties file: 

/BI PLUS/InstalledApps/config/WebAnalysis.properties.  

3. Uncomment and fill in the following lines: 

############## SHARED SERVICES CONFIG#########  
#Shared.Global.Conn.UserName=admin  
#Shared.Global.Conn.Password=password  
#Shared.Global.Conn.HostName=localhost  
#Shared.Global.Conn.Port=58080  
#Shared.Global.Conn.passwordencrypted=false 

Shared.Global.Conn.UserName  username of Shared Services Administrator  
Shared.Global.Conn.Password  password of Shared Services Administrator  
Shared.Global.Conn.HostName  Shared Services host  
Shared.Global.Conn.Port  Shared Services port  
Shared.Global.Conn.passwordencrypted is password of Shared Services 
Administrator encrypted 

4. Register the related content server for a particular application by uncommenting and filling 
in the following lines: 

######################### RELATED CONTENT CONFIG #####################  
#RelatedContent.Server.Name.0=local  
#RelatedContent.Server.Description.0=Hyperion System 9 BI+ On Localhost  
#RelatedContent.Server.URL.0=/workspace/browse/listXML?&sso_token=$SSO_TOKEN$  

#RelatedContent.Server.Version.0=1.2.0  
#RelatedContent.Alias.Name.0=local  
#RelatedContent.Alias.Protocol.0=http 
#RelatedContent.Alias.HostName.0=localhost 
#RelatedContent.Alias.Port.0=19000  

RelatedContent.Server.Name.0  is the string value that is displayed in the 
Add Related Content dialog box. 
RelatedContent.Server.URL  is the uniform resource locator used to launch the 
integrated Hyperion application.  
RelatedContent.Alias.HostName.0  host name for integrated Hyperion 
application.  
RelatedContent.Alias.Port.0=19000  port name for integrated Hyperion 
application.  
RelatedContent.Alias.Name.0  is used to bind RelatedContent.Server.* 
properties to corresponding RelatedContent.Alias.* properties. 

The TargetURL must be in the following format: 
http://<hostname:port>/<webAppURL>?<Applicationspecific  
parameters> 
The applicationspecific parameters are defined by individual integrated 
applications.  
Note: Replacement tags are used within the applicationspecific parameters so 
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that user authentication information can be passed in a consistent way. 
Available replacement tag for WebAnalysis are: $SSO_TOKEN$ 

5. Encrypt Shared.Global.Conn.Password by running one of the following: 

 /BI PLUS/InstalledApps/config/EncryptPasswordUtil.bat 

 /BI PLUS/ InstalledApps/config/EncryptPasswordUtil.sh  

6. Update WebAnalysis.properties and restart the Web Analysis server. [1-224734591] 

WA applet launched from Firefox 2.0 installs JRE 6 Update 1  

The workaround is to manually install jre 1.5.0_11 on the machine, then Firefox will 
automatically use this installed JRE. [8-611582051]  

Incorrect directory tree is created for documents when importing 
presentations  

The original full path of the reports contained in the presentation is recreated under 
“presentation_import_folder”\"_[presentation_name]” subfolder. [8515974381] 

Web Analysis Studio allows Workspace-reserved characters to be saved in 
document names  

Do not use these reserved characters when naming a document in Web Analysis Studio: \ / % ? 
< > | ` [1-295824083] 

Web Analysis is not fully functional in WebSphere cluster  

If you are installing Web Analysis on a WebSphere or WebLogic cluster, and Reporting and 
Analysis paths differ on some of the cluster nodes, perform the following actions before 
deploying the Web application to cluster:  

1. Place WebAnalysis.properties in the same paths on all cluster nodes. 

For example /etc/ on UNIX or C:\Program Files\Common Files on Windows.  

2. Modify web.xml in:  
<BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION>/WebAnalysis/applications/WebA
nalysis.ear 

On Windows: 

a. Select Start > Run, type cmd, and enter the following: 

 > set PATH=<JDK_PATH>\bin•%PATH%%PATH% 
 > mkdir "%TEMP%\watmp" 
 > cd "%TEMP%\watmp" 
 > jar xf C:\832sp4\WebAnalysis.ear WebAnalysis.war 
 > jar xf WebAnalysis.war WEBINF\web.xml 
 > notepad WEBINF\web.xml 

b. In Notepad, press Ctrl+H to open the Replace dialog box. 

c. In Find What, enter <BI+_HOME>\InstallableApps\config. 

d. In Replace With, enter a path from Step 1. 

e. Click Replace All. 

f. Save web.xml and close Notepad. 

g. At the command line, enter the following: 

 > jar uf WebAnalysis.war WEBINF\web.xml 
 > jar uf jar uf C:\832sp4\WebAnalysis.ear WebAnalysis.war 
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h. After last command runs, deploy the following to your cluster: 

<BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION>/ 
WebAnalysis/applications/WebAnalysis.ear  

 On UNIX: 

a. At the command line, enter the following: 

 > PATH=/usr/java14/bin:$PATH 
 > mkdir /tmp/watmp 
 > cd /tmp/watmp/ 
 > jar xf BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION>    
/WebAnalysis/applications/WebAnalysis.ear WebAnalysis.war 
> jar xf WebAnalysis.war WEBINF/web.xml 
> sed 's/<BI+_HOME>\/InstallableApps\/config\ 
//<WEBANALYSIS_PRTOPERTIES_LOCATION>/g' WEBINF/ web.xml >/tmp/$$ && mv 
/tmp/$$ WEBINF/web.xml 
<WEBANALYSIS_PRTOPERTIES_LOCATION> is path from step 1 
Note that you must quote all slashes with a backslash in paths for this 
command. For example, \/home\/hyperion\/ biplus\/InstallableApps\/config 
> jar uf WebAnalysis.war WEBINF/web.xml 
> jar uf <BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION> 
/WebAnalysis/applications/ WebAnalysis.ear WebAnalysis.war 

b. After the last command runs, deploy the following to your cluster: 

<BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION>/ 
WebAnalysis/applications/WebAnalysis.ear [1-240670251] 

Related Content does not function if the session is inactive for 30 minutes  

To change the session timeout in Web Analysis, set the atf.sessionscope.timeout Java 
system property. The default value of this property is 20 minutes. You must synchronize this 
value with the values for HttpSession (see <web app name>\WEB_INF\web.xml for application) 
and bpm framework (see workspace\conf\subcontext.properties). [8-521867635] 

Refresh button in Workspace for Web Analysis content does not prompt to 
save changes before reloading  

Opening a Web Analysis document in Workspace and clicking the Refresh button (either from 
the toolbar or the View menu) reloads the document without prompting you to save, if the 
document was changed (for example, drilling or member selections). [1-177578560] 

Turkish specific: Version in Help->About is not detailed 

When you select Help > About Hyperion Web Analysis Studio, the version number is 
missing in the Server Information section of the dialog box. [8-626659471] 

Workspace User Interface and Navigation 

Unable to reset information in Workspace Administer  

You may encounter problems when resetting values in one or more Administer areas. To work 
around this, cancel the action and start again. [1-275057633]  

Icon with non-English characters in its name is not displayed for mime type  

Japanese character set packages need to be installed on UNIX systems in order to upload icon 
files with Japanese characters in the name. Each system’s installation guide contains 
information concerning additional steps to be done (packages to add) for making Japanese 
characters available. [1-211500841]  
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Tomcat: Unable to use ParameterForm with L1 characters in name 

Any custom forms the user want to upload and use, should not contain non-english characters 
in the file name. [8-580660015]  

Production Reporting exports from Workspace to Word, PowerPoint, and 
Excel 2007 need to be saved and then re-opened 

Production Reporting Office 2007 outputs (Word, PowerPoint and Excel) do not always display 
correctly when using the Workspace Open button. Save these outputs to the desktop and then 
open them again. 

SmartCut keys, values duplicated using with nav_get syntax  

When a SmartCut of the form, withnav_get is used, the URL parameters appear twice when 
accessed via Session object in Interactive Reporting Object Model. [8-607803625]  

Maximum user name length is 250 characters  

The maximum length of the user name is 250 characters. Names that are longer than this may 
not work properly. [8-579695411] 

Itanium: Cannot open Interactive Reporting document via SmartCut when 
encoded JA char contains %bd or %91  

SmartCuts do not work when encoded characters contain %bd or %91 (some Japanese 
characters) when using Apache OR IBM HTTP Server with WebSphere. The issue is isolated to 
the WebSphere plugin to the Apache or IBM HTTP Server.  

To work around this issue, use a SmartCut of the following form:  

http://host:19000/workspace/get?path=<encoded path>  

(Do not use http://host:19000/workspace/get/<encoded path>) [8-576364140] 

BQYs saved to Repository are seen only after refresh  

You must refresh Internet Explorer to view newly added content, after a ‘Save to Repository’ 
action. This is also the case if another user imports and saves another document of any type  
into a folder. All other users with that folder open at the same time must refresh to see the 
newly added content. [8-556762561] 

Production Reporting Word output type can only be viewed when saved to 
end user PC  

To view a Production Report in Microsoft Word format, save the file to the end user machine. 
Pressing the Open button will not open the document. [8-541180651]  

Error after logging in with single sign-on configured  

When using a custom login policy, an error "Module not found: cds.mode" can sometimes 
appear. To correct the error, add the following lines to the Apache Web server configuration 
file, httpd.conf:  

LoadModule sspi_auth_module modules/mod_auth_sspi.so  

<Location /workspace/>  

<Limit POST>  
AuthName "workspace"  
AuthType SSPI  
SSPIAuth On  
SSPIAuthoritative Off  
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SSPIOfferBasic Off  
SSPIBasicPreferred Off  
require validuser  

</Limit> </Location> <Location /workspace/login/>  

AuthName "workspace"  
AuthType SSPI  
SSPIAuth On  
SSPIAuthoritative Off  
SSPIOfferBasic Off  
SSPIBasicPreferred Off  
require validuser  

</Location> [8-520019351] 

Use of BEA JRockit JVM could result in memory leaks  

If deploying Workspace to WebLogic 9, Hyperion recommends using the Sun JVM instead of 
JRockit. Testing with JRockit90_15 resulted in memory leaks that did not occur with other JVMs 
or with older versions of JRockit. The version of JRockit that ships with WebLogic 8 did not 
exhibit this problem and is recommended for WebLogic 8 deployments. [8-513575581]  

When using SmartCuts to navigate Production Reports, the Navigation Bar 
and Table of Contents become embedded deeper with each report jump 

A workaround for this issue when using SmartCuts for Report Surfing is to have the target href 
link point to "_top" so that the Workspace Explorer does not keep embedding the link inside 
itself. [8-512388991] 

An empty page is displayed after opening and Interactive Reporting document 
from generic job output  

If an empty page is displayed when attempting to open an Interactive Reporting document 
from generic job output or a BQD from Product Reporting output, verify that the latest version 
of Interactive Reporting Web Client is installed, and retry. [1-242072367]  

Field validation incorrectly occurs when selecting the Cancel button on the 
Run Job page  

To work around this issue, enter dummy values to satisfy the validations. [1-128575793] 

Open and Save dialog boxes are not accessible when using WebSphere 5.0.2 
on Windows 2003  

Compilation of JSPs at runtime may fail for some class files on WebSphere Application Server 
5.0.2. If the error message displayed is "error 500 failed to compile SomeFilename.JSP," look in 
the WebSphere server's temp directory for a .class file of the same name and delete it. Close 
the browser, log in, and try the offending UI operation again to force the recompile of the failed 
JSP/class file. [1-126574150]  

Reporting and Analysis displays HP app list from HSS without respect to the 
HP cluster causing unwanted behavior 

[8-556411759]  

In Microsoft Internet Explorer 7, menus sometimes overlap or have 
unnecessary scroll bars  

Microsoft Internet Explorer 7 has a new feature that allows you to control whether Web 
applications can open windows of any size. By default, this feature prohibits Web applications 
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from opening windows of any size. This causes menus to be displayed incorrectly in some 
circumstances.  

To display menus correctly: 

1. Select Tools > Internet Options. 

2. On the Security tab, select the Web application's zone, and click Custom Level.  

3. Under Miscellaneous, go to Allow script initiated windows without size or position 

constraints, click Enable.  

4. Click OK, and then Yes, and then click OK again. [8-546856041]  

Logging on to Reporting and Analysis using 
http://server:19000/workspace/index.jsp gives JavaScript errors on Oracle 
Application Server  

Reporting and Analysis on Oracle Application Servers does not allow logon using URLs in the 
form:  

http://server:19000/workspace/index.jsp  

One workaround is to omit index.jsp from the URL. For example: 

http://<server>:<port>/workspace/  

Another workaround is to use the fully-qualified hostname in the URL. For example: 

http://server.domain.com:19000/workspace/  [1-224006021] 

The system intermittently hangs and displays an error message when opening 
a folder after logging in  

When using the Windows operating system, the Hyperion System 9 browser and server 
components should not be run on one computer. If both components must be run on one 
machine for development or demonstrations, however, you must set Windows system 
performance options to optimize applications, not background services.  

To set performance options, open the Windows Control Panel and select System > Advanced 

> Performance Options. [1-118004070]  

Firefox 1.5.0.1 crashes when launching Reporting and Analysis  

Firefox 1.5.0.1 does not work with this release of Reporting and Analysis due to a problem with 
Firefox's JavaScript interpreter. See: 

https://bugzilla.mozilla.org/show_bug.cgi?id=325540 

This problem is corrected starting in Mozilla Firefox 1.5.0.2. [1203592811]  

After changing font size, unable to select correct objects in Workspace  

[8-609661541]  

When index.jsp is used in the URL, Firefox does nothing when Exit is selected 
from Workspace's File menu.  

When Mozilla Firefox is used as the Web browser, and index.jsp is used in the URL (for 
example, http:// biplus_server.company.com/workspace/index.jsp ), selecting File > Exit 
has no effect. Opening Firefox's JavaScript Console shows a message, "Scripts may not close 
windows that were not opened by script".  
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This issue is due to Firefox's security settings. There are two workarounds to the issue:  

� Do not use index.jsp in the URL. This opens Firefox in a separate window which hides 
Firefox's menus, location bar, and toolbar. When Exit is selected from Workspace's File 
menu, a confirmation dialog will display, and the separate window is closed.  

� Use Firefox's about:config page to set dom.allow_scripts_to_close_windows to true. [8-
580853522]  

When a text field is selected in Firefox, the cursor does not display  

When using Firefox, the cursor does not display in some text boxes. One example is the text 
box in the dialog box which opens when the user renames a file or folder. This problem has 
been traced to Mozilla bug 167801. [1-151162889]  

Portlet is not displayed if the time is not synchronized between SAP Portal 
and Hyperion System 9 server  

The system times of the SAP Portal server and the SAP authentication source must be 
synchronized. If they are not synchronized, logging on authentication may be delayed or 
denied. The systems do not need to be in the same time zone, but they should be set to the 
same UTC time. [8-506653561]  

Errors occur when viewing Interactive Reporting or Web Analysis portlets, 
when GSM is configured with WebSphere  

When using the portlets with a version of Websphere Application Server 5.1.1 prior to version 
5.1.1.10 or WebSphere Application Server 6 prior to 6.0.2.9, you must remove the client-
config.wsdd file from <WEBSPHERE_HOME>/lib/ wsif.jar. After saving the updated wsif.jar file, 
restart the WebSphere Application Server. For more information, please see IBM support article 
PK19407 at http://www1.ibm.com/support/docview.wss? uid=swg1PK19407.  [1-394083088] 

Arrows used to move users when assigning Shared Services preferences are 
missing on initial page access  

Images are visible after you log off and log in again, and when you resize the window. [1-
237576241]  

Group preferences are not enforced for newly added users  

Group preferences are applied only to current group members, not to users who are added to 
the group after the group preferences are set. [1-217326076]  

"Version Details" button is missing in workspace help about dialog on HTTPS 
servers  

[8-625751651] 

Oracle SSO / SiteMinder: "Version Details" button in Help>About in 
Workspace is absent  

The "Version Details" button does not appear in the Help > About dialog box. This problem 
occurs if a website policy tool such as Oracle SSO or Netegrity SiteMinder is used.  

Assuming your Workspace server is called workspace_server and you are using port 19000, use 
the website policy tool to unprotect the following URLs ():  

http://workspace_server:19000/WebAnalysis/appinfo.jsp 
http://workspace_server:19000/hr/appinfo.jsp 
http://workspace_server:19000/HpsWebReports/appinfo.jsp 
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http://workspace_server:19000/metrics/appinfo.jsp 
http://workspace_server:19000/HyperionPlanning/appinfo.jsp [8-615194405]  

Logon fails with "Process error" if cookies are disabled  

If a user attempts to logon with a browser that is set to not accept cookies, logon will fail. A 
dialog with the text, "Process Error" will be displayed. Clicking on the "Details" button will show 
either "Syntax error:" for Microsoft Internet Explorer or "missing } in XML expression:" for 
Mozilla Firefox. [8-591824611]  

Reporting and Analysis Release 9.3 does not work with earlier releases of 
Financial Management and Planning that are registered with Release 9.3 
Shared Services  

To enable Reporting and Analysis to launch pre-9.3 versions of Hyperion Planning or Hyperion 
Financial Management, upload an HTML file to the Reporting and Analysis repository and use 
that to launch the application. The HTML file can be pushed as a favorite to groups of users who 
need this functionality. 

To upload an HTML file to the Reporting and Analysis repository: 

1. On the server where the Workspace Web application is running, browse to  
<deployed_workspace_web_application>/WEBINF/samples and open the file for the 
product you want to launch. 

2. Modify the file to refer to your product's server name, port, and the name of the application 
to open. 

3. Save the file and import it into the Reporting and Analysis repository.  

Users who are provisioned with a Reporting and Analysis role and with a role for the 
application should now be able to double click the file and launch the application. To allow 
users with only limited Reporting and Analysis roles (such as only the Viewer role) to access 
the file, you must publish it as a Favorite for these users. 

4. Right-click on the file and select Properties. 

5. Select Edit Permissions. 

6. Enter a user name in the textbox on the left, then click Update List.  

You can also publish files to groups or roles. 

7. Move the user to the box on the right. 

8. Select the user and click Edit. 

9. Select the View and Pushed and click OK. 

10. Select Push this item to selected User, Groups, and Roles and click OK. 

Users will then be able to log on and see the item in the "Favorites" menu. The item will 
have the suffix of "(Pushed)".  [8-510177951]  

SQR Production Reporting jobs in Excel/Word/PPT output open outside the 
Firefox framework  

When using Firefox, documents in common spreadsheets and word processing formats open in 
a separate window; they are not embedded in the browser as when using Microsoft Internet 
Explorer. [1-171197362]  
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Date and time formats in dropdown date selectors are displayed incorrectly  

Throughout Workspace, there are many date and time selectors that do not use a popup 
calendar. Instead, they are made up of dropdowns for month, day, year, hour, minute, AM/PM. 
Depending on the locale, the order of these items may differ from the US order. For example, in 
Korean, the correct order is:  

[Year] [Month] [Day] [AM/PM] [Hour] [Minutes]  

Many dates also display incorrectly using the US format mask mmmddyyyy, instead of being 
displayed in the current locale format.  

Date formatting in Workspace (for date selectors and static labels) is defined by parameters in 
ServletConfigurator. That means you could manually set up any formatting you want (and this 
formatting would be applied everywhere in workspace), but at the same time formatting is no 
longer depend on locale settings. [1-145223858]  

"Version Details" button is missing in the Workspace help about dialog box on 
HTTPS servers 

This problem occurs when the Workspace Web server is using SSL with a self-signed certificate. 
To work around this problem, use the keytool command from the JDK to add the public key of 
the certificate authority that signed the SSL certificate into the JVM of the Workspace Web 
application. 

Top 

Defects Fixed in this Release 

Dashboard Development Services  

CR Number Fixed Defect Description 

1-174636676 Dashboard Builder. Added code to allow table sections to be reparented. 

8-562794338 Dashboard Builder.  Can't change the chart type. 

8-605728512 Dashboard Builder. Sort buttons become invisible if you leave the 
dashboard and come back in. 

Financial Reporting  

CR Number Fixed Defect Description 

1-138089339 Web Viewer.  2108: The object requested: 
[ReportStore:\#92;<reportname>_._2] does not exist in the repository. 

1-403198136 When prompted to select an Entity, users can see all Entities rather than 
only those to which they have access. 

1-144880687 Conditional Format. Supporting Detail format doesn't work when using 
function(@idesc) in Page Dimension. 

1-203374745 Web Preview. Using the refresh button, a report is incorrectly updated 
using the POV of another opened report. 

1-226878941 Functions and Formulas. GetHeading description for "Offset" should 
specify positive only for columns. 
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CR Number Fixed Defect Description 

1-241343186 Web Client. Request to Remove section in Admin Guide referring to 
customizing cascading style sheets. 

1-296043067 Web Viewer. Examples of Cell Text or Planning Annotations in a report. 

1-307840701 Export. Values exported to Excel should be full precision, not rounded as in 
reports. 

3-385869 Documentation. New reports can't be added to new books in duplicated 
folders. 

3-394495 Batch and Scheduling. Batch commands in Hyperion Reports do not work 
when running more than one batch in the command. 

3-121235 Batch and Scheduling.  In the Batch Scheduler, Reports users can send e-
mail notifications but the text of e-mail is in English. 

8-513906635 Client would like Financial Reporting not to have to write in the registry 
especially for users. 

8-521344308 Thousand & Decimal separator set in user preferences not applied when 
running a Book. 

8-521597321 When trying to use Expansion, the sort order is lost. 

8-522440864 5210 Dynamic Time Series error remains and does not allow POV to be 
updated in Workspace. 

8-523413272 Help Contents cannot be displayed in FR Studio. 

8-531552785 5200 error when running reports after Essbase Dimension name has been 
changed. 

8-536062457 If you are running a Book and display the report (in a PDF format for 
example), then change the POV and close, you cannot open any other Book. 

8-537569389 Grid POVs are not rendering alias member names if they have an & in the 
alias name. 

8-538101710 Large numbers of columns in a report may cause printing to hang. 

8-540968118 Pressing X to cancel the delete dialog box in Financial Reporting Studio 
deletes the report anyway. 

8-541624380 After exporting a report to Excel, the second Grid in the report has an 
incorrect format. 

8-541860613 The Conditional Formatting option seems to act strange, and ends up 
causing an error message. 

8-542657986 Financial Reporting creates extra pages and repeat text objects. 

8-545831004 When adding a new report which contains a prompt to an existing Batch, all 
previously set Batch and Report prompts are reset to the defaults. 

8-546462265 Export. Double minus sign when exporting PDF to Excel. 

8-547125418 When opening reports from Related Content, the POV selection window does 
not display completely. 

8-550380853 Member Selection. Substitution variables are not available for selection as 
a Dynamic Time Series argument. 
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CR Number Fixed Defect Description 

8-551570856 Error when changing the database connection of a Financial Reporting report 
when renaming the report with a comma included. 

8-552785260 User POVs have different dimensions visible for different reports users. 

8-553202619 Report cannot be generated for top level entity with more descendants. 

8-558798021 9.3 documentation does not show what version(s) of GhostScript is 
supported for Financial Reporting PDF generation. 

8-562991061 Book reports contain TOC and the individual reports are not sorted correctly 
to sync up with the TOC. 

8-565225635 Changing the language does not reflect to Date function in Financial 
Reporting. 

8-567206449 There are problems with the hs_unix_install.pdf.  

8-568491219 HP ADM: Expansions fail when planners expand on a parent with children 
they do not have access to. 

8-569811220 Financial Reporting Web App jsp compilation causes JRockit to crash. 

8-570471869 Print Server. Text box is truncated in PDF if not viewed in HTML first. 

8-571772113 Error "The following Member Name is not in the Choices List". 

8-573882961 XBRL. The parser assumes that tuple definitions are defined inside the 
element. 

8-578145921 Unable to run report if dimension member is manually entered in formula 
bar and validated. 

8-584093585 The Financial Reporting User's Guide has multiple references to "Change 
Database Connection" in Studio. 

8-585102555 Distiller only. PDF reports may fail if two or more users try to run a report at 
the same time. 

8-585374326 Workspace User Guide fails to indicate that Batch Bursting does not support 
Printer and HTML. 

8-587646468 Unable to run the same report with different POV in Workspace. 

8-587984193 Member Selection. PROMPT Search using wild card crashes Reports 
desktop client. 

8-590026386 Long alias names are cut off in User POV Select Member dialog box. 

8-590058927 Complete Book in PDF returns incomplete/inaccurate results. 

8-596122438 Search using the wildcards does not work in all cases. 

8-596559223 Formatting. Report shows a line in the PDF and Print version although 
there is no line in the report. 

8-596565955 Linked template disappears after moving the report to another location. 

8-597534745 #ERROR while using a variance function in a report with accounts in page 
dimensions. 

8-597783961 Web App can be unresponsive when performing an end task via Task Man or 
X in browser after OK in prompt. 
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CR Number Fixed Defect Description 

8-597784044 Member queries that retrieve huge lists can cause the Financial Reporting 
Web App to become unresponsive. 

8-602052040 The export to Excel with fully-formatted option has the wrong format. 

8-602131285 'Export for Command Line Scheduling' selects the wrong batch if the Batch 
Scheduler window has been sorted. 

8-607272203 Batch "Respond to Prompts" does not refresh after changes to included 
Report/Book. 

8-608992256 'Merge' symptom when opening a report containing a Row Template in 
Studio. 

8-609959163 Responding to Prompts - Selection/de-selection changes members in choice 
list to Expandable Form. 

8-610510002 Cannot open Book Setup menu when Book contains more than four database 
connections. 

8-621624001 Report shows Dimension comments instead of Dimension Names from 
Essbase. 

Foundation Services 

CR Number Fixed Defect Description 

1-100676133 Personal page looks cluttered when Job output is added, such as HTML 
output for Production Reporting. 

 

Infrastructure 

CR Number Fixed Defect Description 

1-YXZBY Possible typo in func/class call? DBTransaction.getDBConneciton() 

1-131701951 Request -Djob_limit=## be changed by a Service Configurator setting..not 
startCommonServices.bat. 

1-241179328 Email notification does not get sent if there is another GIF image in the 
..images\scheduledjob folder. 

8-505734057 No user friendly error message is displayed when an SQR job fails to run. 

8-511683547 V8_QUERY_VW errors on pulling DB_USER against SQL Server. 

8-513643803 Scheduled job cannot be executed on the "End Date" specified in a Recurring 
Time Event. 

8-514018407 BI+ common services is failing to download the CSS xml file from Shared 
Services. 

8-520734737 Need to provide warnings when disk space is running low. 

8-522078143 Unable to view Job output PDF directly when using the SmartCut. 

8-522398234 The word "clients" is confusing in the Backup Strategies chapter section on 
Backing Up Clients. 
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CR Number Fixed Defect Description 

8-522901646 If you execute an "Email Section" action using a Japanese file name, XLS file 
names get garbled. 

8-525980201 ScheduledTask.getEvent() will get ClassCastException if the associated 
event is an externally triggered event. 

8-528616363 The saved parameters disappear after replacing a BQY job. 

8-529154444 Creating externally triggered events does not return the connection to the 
connection pool. 

8-529417300 HPS 8.5 SP1 did not resolve tracking status system bug of user logout. 

8-535368609 When generating ONLY PDF output for a published SQR job, the PDF file will 
not open. 

8-536290504 After using hi85001_windows_conversion_utility to convert 8.3 oce/bqy files, 
you are unable to open new OCE. 

8-539220976 Production Reports that create multiple output files create an empty output 
collection. 

8-542922112 TTL is set for the job output in the Job properties. The scheduled job output 
does not get deleted. 

8-545657801 Exception "COMMON_SessionNotExists:0" when using loadBQY() in a second 
session. 

8-546465055 Similar to 8-529154444. Deleting externally triggered events does not 
return data base connections. 

8-547095899 ProvisionUser() method does not throw any exception when the user does 
not exist in Shared Services. 

8-556438280 Job outputs do not get physically deleted from the actual hard disk. 

8-560111413 Jython SDK issue when using getBQYDocument. 

8-562057400 Pivot refresh setting is ignored for a 'save document' output from HPSU. 

8-563740692 Export fails when there is an apostrophe in a BQY section. 

8-573575070 Put the cached CSS.xml file from Shared Services to a directory other than 
the logs directory. 

8-573715558 BQY temp files not being removed from the tmpfiles/transdir directory. 

8-575883976 Locally saved BQY files lose a link to connection files and cannot be 
processed after conversion. 

8-576586581 Consolidated Job Status reports successful job execution even though the 
'save document' fails. 

8-578119551 When a job sends an email with an attachment on UNIX, it sends the . and 
QUIT together. Windows is ok. 

8-579032474 setDefaultKewords and setKeywords methods are not working with 
SQRProgramDescriptor. 

8-586379142 Error: ‘Unable to gain access to service broker’ 

8-589776196 When changing access control for Job Output on a published job, the 
changes are reflected when run. 
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CR Number Fixed Defect Description 

8-592080691 When running an SQR report from Workspace, an SPF file is output along 
with the PDF file. 

8-592672094 An error appears when trying to set permissions for files and folders. 

8-600789139 The ConfigFileAdmin utility does not work in System 9 to read in the existing 
config.dat file. 

8-606146347 Users are not getting all FTP email notifications. 

8-612759096 Usage Tracking not capturing:  
- Run Interactive Reporting Job  
- Run Production Reporting Job 

8-613597091 *REGRESSION* Repository metadata for Usage Tracking Document 
(Administration) does not match BQY. 

8-614325911 Cookies contain GSM and port information in servlets. 

8-617409663 Concurrent usage of SDK API Job.getProgramOutputs() causing 100% CPU 
on repository. 

8-621584402 Default open format not applied with locales different from English. 

Interactive Reporting 

CR Number Fixed Defect Description 

1-203374764 Intelligence Service. Plugin reference to text box 'this' appears to lose its 
referential value after being tabbed out. 

1-234388764 Export and Export to Stream do not work in iHTML when combined with 
Alert. 

1-124104784 Designer. In the Intelligence Designer Pivot section, the added total 
cannot move from the last position.  

1-354175274 Intelligence Service. "An Intelligence Service error has occurred.-Invalid 
Argument" when clicking links quickly in iHTML. 

1-369026482 Insight. Hardwire mode OLAP Query option needs to be added in Insight. 

1-396711409 Would like to insert a query section without an OCE connection associated. 

1-457083644 Function OpenURL with "_self" argument opens a new window. 

1-161050824 Designer. Pivot table percent of row cume values calculate incorrectly in 
version 8. Correct in version 6.6.4. 

1-167917899 Designer. Unable to open a report section in a BQY. 

1-168951126 Designer. Opening a BQY generates error messages. 

1-81779981 Intelligence Service. The V8_Schedulelog is no longer getting updated in 
8.3.2. This is working in 8.3.1. 

1-187766930 Designer. Help file with the same keyword " Expression Line" is not 
displaying correctly. 

1-209157636 Explorer. HELP file misleading. :TABLE and :COLUMN should not show 
quote marks in Metadata set-up. 
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CR Number Fixed Defect Description 

1-219685331 Designer. The documentation should indicate that Sections.Add is not an 
available method for Dashboard. 

1-220399101 Designer. Errors obtained in a report section after renaming a results 
section. 

1-230451295 Explorer. Dashboard charts do not display the correct sort order when the 
chart is sorted by Computed Item. 

1-237647827 IHTML Client.  Export to Excel format is in HTML. Requires the old XLS 
format. 

1-250751546 Explorer. CLOB got truncated at 4000 char. Help file is incorrect (it said it 
can go up to 9999 char). 

1-397734041 Designer. OLAP query should have option to choose 'member name' rather 
than only Alias Table. 

1-406533063 Designer. "Exponential" and "Weighted"setting does not work using the 
Trend function in Designer Japanese. 

1-155233884 Insight. Alt+End takes a while to cancel a query from Insight. 

1-202802411 Insight. The collate print option does not work in Insight and Designer. 

4-BRIO100028330 IHTML Client. TCPivot: Incorrect auto-sizing of data labels located down 
side. 

4-BRIO100028943 Designer. Reports display no data until they are first exported to HTML. 

8-507584029 Insight. Show Values list is empty listing large number of records using 
PSU 8.5 Insight. 

8-510835292 Designer. A BQY file that runs fine in 830 throws an error in 850 and 85 
SP1. 

8-520872015 *REGRESSION* Incorrect behavior regarding "fast fetch" mode in 
Interactive Reporting Studio and DAS. 

8-522072431 ExportToStream from HTML invokes printing functionality. 

8-522123429 Text field display limited to 15 characters in Interactive Reporting Studio 
when table is VIEW. 

8-522723377 Designer. Cannot remove the  "Ignore Limit" button in iHTML. 

8-523827384 Insight. Join uses Best Guess even though Server Defined is selected. 

8-524031842 Intelligence Service. A job finishes without errors using "Process results 
to database table" option. 

8-524936211 *REGRESSION* Export of Report section concatenating data into a single 
cell. 

8-525994326 The predefined bar chart color changes when a new fact is added or a fact 
sequence is changed. 

8-527309994 Transparent property is ignored in HTML-client. 

8-529193680 Designer. Unknown error occurred when script is run on the on Exit event. 

8-530238144 Designer. Metadata connection, unknown error received on certain tables. 
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CR Number Fixed Defect Description 

8-530522389 Data truncation with Teradata. 

8-530865031 Designer. Computed items not appearing correctly in newer versions of 
Designer. 

8-531747837 When duplicating the query using metadata, physical table names and 
system tables are displayed. 

8-531932821 Designer. Exporting a landscape pivot section to PDF truncates the data. 

8-534420374 Designer. Metatopic item definitions are altered when their alias is 
modified. 

8-535304801 *REGRESSION* Poor query performance. Queries that once utilized indexes 
on tables no longer do. 

8-536385885 IHTML Client. Bug with text box fields when set to 'Password'. 

8-537366124 DAS. Does not handle Oracle Password Expiration notices properly. From 
Intelligence Client get ORA:2800. 

8-538084068 IRS: Prompts in Filters do not work in the HTML client. 

8-538490471 Table is emptied after importing a BQY from Dashboard Builder. 

8-539373891 DAS. Does not handle Oracle Password Expiration notices properly. From 
Intelligence Client get ORA:2800. 

8-539635351 Insight. Need to add support for MS Windows Vista. 

8-543088781 Automatic Document Refresh (ADR) in Web Client creates incorrect results. 

8-543944934 Insight. Not all values are returned when processing multiple OLAPQuerys 
against Essbase at the same time. 

8-546721978 Need to add an option to open multiple Interactive Reporting Web Client 
Plugins for a single session. 

8-555924911 Unable to install Interactive Reporting Web client, after doing the required 
changes using HC2003-AmexRisk environment. 

8-562535734 PDF corrupted when exporting via Firefox in iHTML and Insight. 

8-562587685 Intelligence Service. BIService accepts multiple request even when 
MAX_CONCURRENT_JOB_REQUESTS=1. 

8-563033030 The pivot color in version 9.2 is different than in version 8.3.2 SP3. 

8-564448695 DAS. When a job is cancelled via the Job Manager, the query running on 
the source database is not cancelled. 

8-564911751 Incorrect character displayed in job notification email body. 

8-566667807 Designer. Ability to query dates stored as measures in Essbase. 

8-566710760 Moving items in list box on a dashboard section (Interactive Reporting 
Studio) has a memory leak issue. 

8-566985831 Textbox OnChange event fires twice in Designer, Plugin. 

8-569992778 The document script fails when it is password protected. 

8-571627271 Unable to install plugin if PC regional setting and browser locale to Spanish 
(Mexico). 
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CR Number Fixed Defect Description 

8-572584657 IHTML Client. Rename the section in the iHTML view even though the user 
is having view access to the BQY file. 

8-575245131 Intelligence Service. With new DST changes, variable BQY jobs limits 
based on custom values set incorrectly. 

8-575538918 Insight. Error "an unknown error has occurred" when adding fields to the 
facts in a pivot. 

8-576227210 BQ Pivot - IR/Essbase: Totals incorrect when a Data Function applied to 
Total. 

8-576754084 Usage Tracking is not populating the Object Name and Path for BQY 
joboutputs open in the Interactive Reporting Plugin. 

8-576757931 Incorrect display name in tooltips for <... of ...> members. 

8-577922955 "Show as Chart" generates a 3D chart without depth. 

8-577959121 Incorrect error message "unmatcheddatatype exception" if the source 
document deleted. 

8-578877361 Insight. Insight textbox(es) become disabled when modifying IE "Search" 
settings. 

8-580883222 Plugin opens BQY files with an error and will not process in IIS 6/WebLogic 
Professional 9.1 environment. 

8-586621056 Using System 9 IR V9.2.0.x with IIS/Tomcat, Interactive Reporting plugin 
process is not working when using hostname. 

8-587264021 "Interactive Reporting Viewer" role not honored in HTML mode. 

8-588230339 Notification with SMTP authentication does not work. 

8-588990785 Missing computed_item.html, ch18s04s03.htm files in 9.3.0.1 Interactive 
Reporting Studio help. 

8-589003930 Cannot open URLs that contain Japanese DBCS characters using Interactive 
Reporting Web Client. 

8-591123271 When the "Text Wrap" option is used in a report column, it gets truncated 
in the HTML client. 

8-591340704 Interactive Reporting jobs do not report errors when the FTP program is 
non-existent or cannot be found. 

8-591464687 Error when using the same table twice and using German briottbl.txt file. 

8-592629224 BIService throws core on Solaris 10 UltraSPARC IIIi machine. 

8-592858211 DAS. Impersonation for cell level security in MSAS 2005 does not work. 

8-593087461 Unable to "save to repository" with the Interactive Reporting Web Client 
using Mozilla when IE7 is installed on same machine. 

8-593588082 Email messages (from email action of a job) contain spaces in the middle of 
words. 

8-593791489 Designer. Switching between vertical stack bar chart and bar/line does not 
hide the right axis. 

8-594632501 Export to Excel 2000 is no longer supported via iHTML toolbar/menus.  
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CR Number Fixed Defect Description 

8-596326482 Insight. Unable to process query has VARIANCE, STDDEV, WEIGHT data 
function. 

8-596537393 Selected index property is not populated with a "1" automatically. 

8-597583175 Designer. DECODE function does not work correctly using PSU 8.5.x with 
SQL Net connection. 

8-598953627 Broadcast Server. Every 7th or 8th Chinese character in an email body is 
replaced by a junk "=" character. 

8-604664335 Designer. *REGRESSION* Stored procedure call does not work in 8.5, 
even though it works in 8.3.2. 

8-605341631 PDF output not proper. 

8-605341661 Designer. DBCS upper case alphabet characters get displayed differently 
from the prior release using PSU 8.5. 

8-605700679 Designer. "ActiveDocument.Sections["D"].Shapes["P"]. 
ScrollbarsAlwaysShown = true;" does not refresh the dashboard. 

8-609124217 Unable to connect to Netezza 3.1.2. 

8-610874701 Designer. Designer freezes doing a specific operation and using a specific 
DBCS Japanese named table name. 

8-611355285 Browser crashes when closing a BQY with an embedded browser pointing to 
an object on System 9. 

8-611797740 When printing from Interactive Reporting Studio/Insight, collate does not 
work. 

8-611875305 Wrong total in computed iHTML column. 

8-614671583 Ability to open BQY in Web Client mode in a separate browser window. 

8-619476078 Using System 9 IR V9.2.0.x with IIS/Tomcat, the Interactive Reporting 
plugin process is not working when using hostname. 

8-622956821 Unable to save BQY after adding a computed item using the Picture 
function. 

Migration 

CR Number Fixed Defect Description 

1-166161642 The Migration Utility version 2.1.3 fails to convert files that contain a 
"double byte wave dash character". 

8-516433381 Row Level Security migration from Intelligence V6.4.x to PSU 8.5 fails. 

8-532069775 Detail logging for all items that fail during migrations. 

8-534973961 URL information in locally-saved BQYs gets lost after running the 
brioqry_s.exe utility. 

8-605352151 Problems while migrating users from version 8 to version 9. 
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Performance Scorecard 

CR Number Fixed Defect Description 

1-191355679 Maps. Client would like to display long measure descriptions in tree 
elements. 

1-253673001 Notes. Attached document show the Notes links found to be broken. 

1-354461893 Dimensions. Improve multi-dimensional measure building performance. 

8-508908735 Reports. Ability to filter by initiative status in the Initiative report. 

8-509725569 Measures. Client wants to distribute based on measures within each 
perspective. 

8-511721638 Scorecards. A new named range assigned to a measure fails to appear in 
the General tab. 

8-514591020 Initiatives. When a sub-initiative is created, it takes on attributes of the 
parent. 

8-514591033 The Paste function is not working when trying to copy an initiative. 

8-519137343 Employees. Change terminology from “Manager” to “Direct Reports” in the 
Managed Employees dialog box. 

8-520469434 When converting models, not all status indicators images are set - some 
had to be reset manually. 

8-527711942 Designer having issues with Web page restrictions. 

8-530661832 Notes. In the measure notes screen, the header cannot be changed to 
update the list of notes displayed. 

8-550925264 Scorecards. Chart colors do not display properly. 

8-561062341 Measures. Measure Template frequencies are not assigned to Targets. 

8-573063915 Reports. Collection dates in the measure target collection tab are not 
shown properly. 

8-576121622 Promotion does not show correct information. 

8-584487910 Installation and Configuration. HPS deployed on IBM WebSphere 
6.0.2.11 has some interface errors. 

8-612778680 Scorecards. Incorrect order of perspectives and measures in the Object 
View – Scorecard tab. 

8-612778936 Measures. Not possible to change measure order by drag-and-drop. 

8-620394399 Maps. Incorrect display of Hebrew characters. 

8-620816628 Measures. A measure with a formula on a custom target disappears in 
Scorecard Report. 

Shared Services 

CR Number Fixed Defect Description 

1-10Q21V Common Licensing. An error occurs when trying to start the License 
Server as a service. 
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1-116577524 Configuration Utility. Unable to skip Shared Services registration for 
Essbase. 

1-352626531 Users. CSS is making two calls when authenticating with LDAP Directory 
Server. 

8-517957911 Provisioning. When running the View Report in Shared Services, only the 
first 50 or so users are available. 

8-519214292 Provisioning. Incorrect group membership for users with the same CN. 

8-530223837 Providers. Fetch DNs does not work for SSL external providers. 

8-536186003 Provisioning. When moving a provisioned user in MSAD, no further 
provision is possible on Workspace objects. 

8-536209942 Provisioning. Unable to display over 100 Native Groups for the BI+ 
project in Shared Services. 

8-557285927 Provisioning. Logging / Log file of the actions of the import export utility is 
not adequate for customer use. 

8-559436548 Providers. Cannot create a report for one user via the Administration 
menu in Shared Services. 

8-563909351 Export/Import. When import provisioning data as update mode from CSV 
file, only "Provisioning Manager" was updated. 

8-573879039 Export/Import. Need to ensure that CSS Identity remains the same 
during an export, followed by an import. 

8-580200732 Groups. Unable to Edit groups in HSS once saved. The option to EDIT is 
disabled. 

8-596193621 Provisioning. Problem running Security Export in HSS 9.3.0.1 for all users, 
groups or roles that have special characters. 

8-596485361 Server. Error: Cannot open shared library: /raja/bdbbinaries/lib/libdb-
4.2.sl when running db_recover. 

8-602122623 Login. Unauthorised access to administrative functions in Shared Services. 

8-605926930 Provisioning. Shared Services not clearly distinguishing multiple MSAD 
users with the same name. 

8-606430118 Providers. Password is stored in clear text in Import Export utility 
properties file. 

8-610576111 Export/Import. Provisioning Information for Planning Applications is not 
being exported. 

SQR Production Reporting 

CR Number Fixed Defect Description 

1-376772399 Paths to SRM files should tolerate all characters Microsoft Windows 
tolerates. Wrong message given. 

1-430234540 Should not stop SQR if there is a DB2 warning. 

8-540607511 SQR fails with SQR 7780 if member names contain ' (inverted comma). 
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8-552784979 Need to add more details about -GD_DRIVER:WORD and -GD_DRIVER:PP  
in the documentation. 

8-554172237 SQR Developer does not quote "!" correctly in dimension/member names. 

8-554662511 Dimensions are displayed as leafs if their names contain umlauts (ä, ö, ü, 
...) 

8-554855443 REGRESSION: Query Builder unable to access databases other than first. 

8-563740442 SQR PDF output in UNIX using TTF requires the TTF to be in the same 
directory as the SQR file. 

8-573850993 When adding a % sign in front of EAN 128 Barcode, the barcode generated 
is not right. 

8-576503088 The reserved variable $username is returning an incorrect value. 

8-607623173 Charts lose decimal information when a comma is used as decimal sign 
when run on French-localized Windows. 

User Provisioning 

CR Number Fixed Defect Description 

1-366780671 Changes in MSAD are not detected by CSS. 

8-519214276 Previous provisioning applied after deleting/adding a user. 

Web Analysis 

CR Number Fixed Defect Description 

1-256876697 The sand glass disappears after clicking, even if there is a current action 
going on. 

1-221430441 Dimension Subset definitions are incorrectly applied to Web Analysis 
reports. 

1-245405031 EDS interop: Attribute dimension members are not retrieved if EDS is 
enabled. 

1-256933350 Export to XL Columnization. 

1-332405407 Tooltip not available on some buttons on the toolbar for Web Analysis 
reports opened from Workspace. 

1-370615762 The Parent dimension element is moved when using "Remove Only". 

1-404099350 The alias controller subscription button seems to be doing multiple 
retrievals unnecessarily. 

1-453463821 The border around the time drop down does not appear after converting 
from 9.0.1 to 9.2. 

1-487793795 Using Bolded fixed fonts- spacing too wide taking real-estate. Using font 
Reuters Mono 11. 

1-488289992 FMR - printing whole report (with multiple report tabs) very slow. 
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8-511399224 In Workspace/Web Analysis, the dimension browser has no horizontal scroll 
bar. 

8-511872141 Web Analysis export to Excel does not work with our client machines. 

8-516090271 Workspace rendering of Web Analysis page dimensions not available. 
Format display is also different. 

8-518836684 Next and Previous tab service buttons do not work in Workspace. 

8-522192133 The lection button does not allow re-linking. 

8-525983115 Incorrectly return to the page drilled from when closing the drill-linked 
page. 

8-526304958 Member Search incorrectly finds a shared member/alias, instead of a stored 
member. 

8-526305183 Ability to bypass suppressed confirmation popup boxes (Home button and 
Drill link). 

8-532979543 "Traffic light" combo needs to be available only if pinboard is focused. 

8-533551217 Unable to edit data if metaread filter is applied. 

8-535499363 Web Analysis login not possible with supported JRE (1.4.2) going via a 
Proxy Server. 

8-537100317 SQL Spreadsheet content is not refreshed upon page dimension changes. 

8-545800737 "-" and spaces are not displaying correctly in Excel when importing a report 
from Web Analysis. 

8-546383959 Unable to export to Excel. 

8-546673081 Sequence manager generates non-unique ID for Web Analysis objects. 

8-550516929 Font Formatting in a Web Analysis report fails to reflect when the report is 
displayed in Workspace. 

8-552568178 When closing the Analyzer window with the X button, a message with a 
warning need to be displayed. 

8-564593775 "Training wildcard searches" at page 279 of wa_user.pdf. 

8-565677575 Substitution variable is not displayed with description/alias but member 
name. 

8-566194321 When selecting a drill through option in Web Analysis 9.2, the related 
content is empty. 

8-567613947 When opening a Web Analysis report that contains errors, another report 
opens in WS. 

8-571728485 Dynamic Time Series always defaults to History to Date and Quarter to 
Date in Workspace. 

8-575938516 The Java Web Client dumps NullPointerException and displays the message 
'Load Data Failed'. 

8-578917161 When using filters, write back to Essbase via Workspace is not possible with 
write access rights. 
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8-583899122 Changing the report database fails when logged in through SSL/IIS. 

8-586230008 The preferences are set in Web Analysis, but if the same user logs into 
Workspace, they are not set. 

8-586423180 Exporting a fully-formatted table to Excel incorrectly rounds the decimal 
values. 

8-596051561 Some spreadsheet options defined in the Java client are not honored by 
Thin client. 

8-594587044 It is impossible to create a report against a data source with special 
symbols in the name. 

8-596804653 "View Pane" property from User Settings does not work in Workspace. 

8-614584487 The Suffix format does not work on its own. 

8-616358329 "Explorer rights" allow browse possibilities in Workspace unlike in Web 
Analysis. 

8-616388231 Extend URL character maximum to 256 versus the current maximum of 80 
in "Launch External Browser". 

Workspace User Interface and Navigation 

CR Number Fixed Defect Description 

1-112208941 Change the text "Scan all of HPS". 

1-127572187 Change "Intelligence Service" to "Interactive Reporting" in LSC. 

1-128965914 Need to use the same naming standard/format. 

4-BRIO100027934 Schedules/job parameters are corrupted when the output folder they are 
pointing to is deleted. 

8-508813391 Provide support for MS Internet Explorer v7.0. 

8-511438421 i18N: Jobs are scheduled for tomorrow if the server is in another time zone. 

8-513574343 Setting the datasource to "Microsoft OLE DB Provider for Analysis Services 
8.0" in DAS will be automatic. 

8-520929191 Need to add a global option to specify default open format for Interactive 
Reporting documents. 

8-524157284 In Favorites, the BQY files always open in HTML regardless what the Default 
Open Format is set to. 

8-530064011 You can specify a Financial Reporting report as a home page, but it always 
displays in HTML rather than PDF format, no matter how user preferences 
are set. 

8-532334278 SQL generated for custom variable date limits off by one hour for some time 
zones/DST settings 

8-533953569 Session.URL does not return session values. 

8-544638654 Need to add a preference to not automatically open the Document pane. 

8-552557531 Setting Interactive Reporting preferences to Switzerland breaks Workspace. 
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8-553589863 Uses are prompted for  username and password twice in order to login in 
using SmartCut. 

8-554064751 DST testing with new JRE - event times are being changed before DST 
change. 

8-556762511 In the Web Client, you are unable to save description for BQY from "Save to 
Repository dialog". 

8-558564093 Default Open Format in Interactive Reporting Preferences appears to be 
ignored when opening Interactive Reporting reports in certain ways. 

8-558690237 Incorrect behavior creating Events for scheduling. 

8-564066190 Events are displayed in a random order. Makes finding an event difficult. 

8-575568285 Access control is not working correctly when filtering events in Manage 
Events. 

8-584452759 WS: Apply properties to multiple children at once. 

8-590137232 System does not retain the RTE settings when creating an event using 
'Every' interval. 

8-596584184 Unable to upload a BQY with variable limits when the time zone is set to 
GMT or GMT+1, works with GMT+8. 

8-597996520 Modified Parameter name cannot be changed and exceed 50 characters. 

8-601031837 Need to support WebSphere V6.1.0.7 as the Web application server using 
System IR V9.2.0.x. 

8-601417079 Append Date to Filename, Filename, and Append Unique Identifier to 
Filename options do not work properly. 

8-602131318 The Default Open Format option in preferences is not taken into account 
when the browser is set to Spanish. 

8-606163104 Impossible to select a Filter for a job with a Variable Filter. 

8-607271949 If using https, we must call an additional api while creating cookies to make 
it "secure" cookie. 

8-609450014 Unable to close content in My Personal Page without closing the Personal 
Page. 

8-624002443 *.inc files containing code should not be downloadable from Workspace. 
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Third-Party License Appendix 

Cyrus SASL 

Copyright © 1994-2003 Carnegie Mellon University. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
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1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.  

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

3. The name "Carnegie Mellon University" must not be used to endorse or promote products 
derived from this software without prior written permission. For permission or any legal 
details, please contact: 

Office of Technology Transfer 
Carnegie Mellon University 
5000 Forbes Avenue 
Pittsburgh, PA  15213-3890 
(412) 268-4387, fax: (412) 268-7395 
tech-transfer@andrew.cmu.edu 

4. Redistributions of any form whatsoever must retain the following acknowledgment: 

"This product includes software developed by Computing Services at Carnegie Mellon University 
(http://www.cmu.edu/computing/)." 

CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS 
SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN 
NO EVENT SHALL CARNEGIE MELLON UNIVERSITY BE LIABLE FOR ANY SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER 
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE 
OF THIS SOFTWARE. 

JPEG 

This software is based in part on the work of the Independent JPEG Group. 

WSRP Web Part Toolkit for SharePoint Products and Technologies 

WSRP authors provide no warranty whatsoever for WSRP Web Part Toolkit performance. WSRP 
authors maintain no liability for WSRP Web Part Toolkit. 

Top 
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